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About This Guide

IMPORTANT! Before using this product, read and understand the information in the
“Safety” appendix in this document.

Revision history

Revision Date Description
A July 2014 New document.
B October 2014 Add Chapter 5.

Purpose

The Yfiler® Plus PCR Amplification Kit User Guide provides information about the
Life Technologies instruments, chemistries, and software associated with the Yfiler®
Plus PCR Amplification Kit.
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B Product OVEIVIEW . . . oot e e e e e 9
B Workflow overview for casework samples. ............. ..., 13
B Workflow overview for database samples .............. ... ... ... ... .... 14
B Instrument and software Overview . ............. . e 15
B Materials and equipment .......... ... o i 17
Product overview
Pu rpose The Yfiler® Plus PCR Amplification Kit is a 6-dye, short tandem repeat (STR) multiplex

assay optimized to allow amplification from multiple male-specific sample types such
as male-male, male-female mixtures and direct PCR amplification from the following
types of single-source samples:

Blood and buccal samples on treated paper substrates without the need for
sample purification.

Blood samples collected on untreated paper substrates and treated with Prep-n-
Go™ Buffer

Buccal samples collected on swab substrates and treated with Prep-n-Go™ Buffer

Yfiler® Plus PCR Amplification Kit amplifies 27 Y-STR loci in a single PCR
amplification reaction.

Product The Yfiler® Plus Kit contains all the necessary reagents for the amplification of human
description male-specific genomic DNA.

The reagents are designed for use with the following Life Technologies instruments:

Applied Biosystems® 3500/3500xL Genetic Analyzer

Applied Biosystems® 3130/3130x! Genetic Analyzer

GeneAmp® PCR System 9700 with the Gold-plated Silver 96-Well Block
GeneAmp® PCR System 9700 with the Silver 96-Well Block

Veriti® 96-Well Thermal Cycler

Substrates Possible substrates for use with this kit include:

Treated paper: Copan NUCLEIC-CARD System or Whatman FTA® cards
Untreated paper: 903 paper, Bode Buccal DNA Collector™™

Yfiler® Plus PCR Amplification Kit User Guide 9



1 Overview
Product overview

About the primers Non-nucleotide linkers are used in primer synthesis for the DYS3891/1I, DYS635,
DYS627, DYS19, YGATAH4, DYS448, DYS391, DYS390, DYS438, DYS391, DYS390,
DYS438, DYS392, DYS518, DYS437 and DYS449 loci. For these primers, non-nucleotide
linkers are placed between the primers and the fluorescent dye during oligonucleotide
synthesis (Butler, 2005, Grossman et al., 1994, and Baron ef al., 1996). Non-nucleotide
linkers enable reproducible positioning of the alleles to facilitate interlocus spacing.
The combination of a six-dye fluorescent system and the inclusion of non-nucleotide
linkers allows for simultaneous amplification and efficient separation of the 27 Y-STR
loci during automated DNA fragment analysis.

Loci ampl_ified by The following table shows the loci amplified and the corresponding fluorescent

the kit marker dyes. The Yfiler® Plus Allelic Ladder is used to genotype the analyzed
samples. The alleles contained in the allelic ladder and the haplotype of the DNA
Control 007 are also listed in the table.

Table 1 Yfiler® Plus Kit

des"i;f‘::’ion Alleles included in Yfiler® Plus Allelic Ladder laDz:l ;ﬁztggfl
DYS576 10, 11, 12, 13, 14, 15, 16, 17, 18, 19, 20, 21, 22, 23, 24, 25 6-FAM™ | 19
DYS389I 9,10, 11, 12, 13, 14, 15, 16, 17 13
DYS635 15, 16, 17, 18, 19, 20, 21, 22, 23, 24, 25, 26, 27, 28, 29, 30 24
DYS38911 | 24,25, 26, 27, 28, 29, 30, 31, 32, 33, 34, 35 29
DYS627 11,12, 13, 14, 15, 16, 17, 18, 19, 20, 21, 22, 23, 24, 25, 26, 27 21
DYS440 7,8,9,10, 11,12, 13, 14 VIC® 11
DYS458 11,12, 13, 14, 15, 16, 17, 18, 19, 20, 21, 22, 23, 24 17
DYS19 19,10, 11, 12, 13, 14, 15, 16, 17, 18, 19 15
YGATAHA 8,9,10, 11,12, 13, 14, 15 13
DYS448 14,15, 16, 17, 18, 19, 20, 21, 22, 23, 24 19
DYS391 5,6,7,8,9, 10,11, 12, 13, 14, 15, 16 11
DYS456 10,11, 12, 13, 14, 15, 16, 17, 18, 19, 20, 21, 22, 23, 24 NED™ 15
DYS390 17,18, 19, 20, 21, 22, 23, 24, 25, 26, 27, 28, 29 24
DYS438 6,7,8,9, 10,11, 12,13, 14, 15, 16 12
DYS392 4,5,6,7,89, 10,11, 12, 13, 14, 15, 16, 17, 18, 19, 20 13
DYS518 32,33, 34, 35, 36, 37, 38, 39, 40, 41, 42, 43, 44, 45, 46, 47, 48, 49 37
DYS570 10, 11, 12, 13, 14, 15, 16, 17, 18, 19, 20, 21, 22, 23, 24, 25, 26 TAZ™ 17
DYS437 10,11, 12, 13, 14, 15, 16, 17, 18 15
DYS385 6,7,8,9, 10, 11, 12, 13, 14, 15, 16, 17, 18, 19, 20, 21, 22, 23, 24, 25, 26, 27, 28 M4
DYS449 22,23, 24, 25, 26, 27, 28, 29, 30, 31, 32, 33, 34, 35, 36, 37, 38, 39, 40 30
DYS393 7,8,9,10, 11,12, 13, 14, 15, 16, 17, 18 SID™ 13
DYS439 6,7,8,9, 10,11, 12, 13, 14, 15, 16, 17 12
DYS481 17,18, 19, 20, 21, 22, 23, 24, 25, 26, 27, 28, 29, 30, 31, 32 22
DYF387S1 | 30,31, 32, 33, 34, 35, 36, 37, 38, 39, 40, 41, 42, 43, 44 35,37
DYS533 7,8,9,10, 11,12, 13, 14, 15, 16, 17 13

10 Yfiler® Plus PCR Amplification Kit User Guide



Chapter 1 Overview 1
Product overview

Allelic ladder Figure 1 shows the allelic ladder for the Yfiler® Plus Kit. See “Allelic ladder
profile requirements” on page 33 for information on ensuring accurate genotyping.

Figure 1 GeneMapper® ID-X Software v1.4 plot of the Yfiler® Plus Allelic Ladder
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Product overview

Control DNA 007
profile

12

Figure 2 shows amplification of Control DNA 007 using the Yfiler® Plus Kit.

Figure 2 1 ng of Control DNA 007 amplified with the Yfiler® Plus Kit and analyzed on the Applied

Biosystems® 3500xL Genetic Analyzer
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Workflow overview for casework samples

Workflow overview for casework samples
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1 Overview
Workflow overview for database samples

Workflow overview for database samples
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Chapter 1 Overview
Instrument and software overview

Instrument and software overview

Data Collection and
GeneMapper® ID-X
Software

Instrument and
software
compatibility

About
multicomponent
analysis

How
multicomponent
analysis works

This section provides information about the Data Collection Software versions
required to run the Yfiler® Plus PCR Amplification Kit on specific instruments.

The Data Collection Software provides instructions to firmware running on the
instrument and displays instrument status and raw data in real time. As the
instrument measures sample fluorescence with its detection system, the Data
Collection Software collects the data and stores it. The Data Collection Software stores
information about each sample in a sample file (.fsa), which is then analyzed by the
GeneMapper® ID-X Software.

Table 2 Software specific to each instrument

Instrument Operating Data Collection Analysis software
system Software
3500/3500xL e Windows® XP 3500 Series GeneMapper® /D-X Software
o Windows Data Collection | v1.4 or higher
Vista® Software v1.0
and v2.0
3130/3130x( Windows® 7 4.0

Life Technologies fluorescent multi-color dye technology allows the analysis of
multiple loci, including loci that have alleles with overlapping size ranges. Alleles for
overlapping loci are distinguished by labeling locus-specific primers with different
colored dyes.

Multicomponent analysis is the process that separates the six different fluorescent dye
colors into distinct spectral components. The five dyes used in the Yfiler® Plus Kit to
label samples are 6-FAM ™, VIC®, NED", TAZ, and SID dyes. The sixth dye, LIZ® dye,
is used to label the GeneScan"" 600 LIZ® Size Standard v2.0.

Each of these fluorescent dyes emits its maximum fluorescence at a different
wavelength. During data collection on the Life Technologies instruments, the
fluorescence signals are separated by diffraction grating according to their
wavelengths and projected onto a charge-coupled device (CCD) camera in a
predictably spaced pattern. The 6-FAM ™ dye emits at the shortest wavelength and it is
displayed as blue, followed by the VIC® dye (green), NED™ dye (yellow), TAZ dye
(red), SID dye (purple) and LIZ® dye (orange).

Although each of these dyes emits its maximum fluorescence at a different
wavelength, there is some overlap in the emission spectra between the dyes (Figure 3).
The goal of multicomponent analysis is to correct for spectral overlap.

Yfiler® Plus PCR Amplification Kit User Guide 15
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Instrument and software overview

Figure 3 Spectral calibration of the six dyes used in the Yfiler® Plus Kit
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Chapter 1 Overview 1
Materials and equipment

Materials and equipment

Kit contents and The Yfiler® Plus PCR Amplification Kit is available in two sizes:

storage * 100 reactions (Cat. no. 4484678) —This kit contains enough reagents for two sets of
50 reactions.

* 500 reactions (Cat. no. 4482730) — This kit contains enough reagents for two sets of
250 reactions.

IMPORTANT! The fluorescent dyes attached to the primers are light sensitive. Protect
the primer set, amplified DNA, allelic ladder, and size standard from light when not in
use. Keep freeze-thaw cycles to a minimum.

Component Description 100 reactions 500 reactions Storage
Yfiler® Plus Contains enzyme, salts, dNTPs, 2 tubes, 4 tubes, -15 to -25°C on receipt,
Master Mix bovine serum albumin, and 0.05% | 0.5 mL/tube 1.25 mL/tube 2 to 8°C after initial use

sodium azide in buffer and salt.
DNA Contains 2.0 ng/uL human male 1 tube, 0.05 mL 2 tubes,
Control 007 genomic DNA in 0.05% sodium 0.05 mL/tube

azide and buffert.

See Table 1 on page 10 for profile.

Yfiler® Plus Contains locus-specific dye- 2 tubes, 2 tubes, -15 to -25°C on receipt,

Primer Set labeled and unlabeled, forwardand | 0.25 mL/tube 1.25 mL/tube 2 to 8°C after initial use
reverse primers to amplify human Store protected from
male DNA target. light.

Yfiler® Plus Contains amplified alleles. 2 tubes, 2 tubes,

Allelic Ladder See Table 1 on page 10 for a list of 0.025 mL/tube 0.05 mL/tube

alleles included in the allelic
ladder.

t The DNA Control 007 is included at a concentration appropriate to its intended use as an amplification control (i.e., to provide confirmation of
the capability of the kit reagents to generate a profile of expected genotype). The DNA Control 007 is not designed to be used as a DNA quantitation
control, and you may see variation from the labelled concentration when quantitating aliquots of the DNA Control 007.

Standards for For the Yfiler® Plus Kit, the panel of standards needed for PCR amplification, PCR
samples product sizing, and genotyping are:

e DNA Control 007 — A positive control for evaluating the efficiency of the
amplification step and STR genotyping using the Yfiler® Plus Allelic Ladder.

* GeneScan'" 600 LIZ® Size Standard v2.0 - Used for obtaining sizing results. This
standard, which has been evaluated as an internal size standard, yields precise
sizing results for Yfiler® Plus Kit PCR products. Order the GeneScan™" 600 LIZ®
Size Standard v2.0 (Part no. 4408399) separately.

* Yfiler® Plus Allelic Ladder — Allelic ladder developed by Life Technologies for
accurate characterization of the alleles amplified by the Yfiler® Plus Kit. The
Yfiler® Plus Allelic Ladder contains most of the alleles reported for the 27 loci.
Refer to Table 1 on page 10 for a list of the alleles included in the Yfiler® Plus
Allelic Ladder.

Yfiler® Plus PCR Amplification Kit User Guide 17
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I'::;Z?rrer; tzgssupplied reagents
Section 2.1 Amplification from extracted DNA

Required user-supplied reagents

In addition to the Yfiler® Plus Kit reagents, the use of low-TE buffer (10 mM Tris,
0.1 mM EDTA, pH 8.0) is recommended. You can prepare the buffer as described in the
procedure below or order it from Teknova (Cat # T0223).

To prepare low-TE buffer:

1. Mix together:
e 10mL of 1 M Tris-HCI, pH 8.0
e 0.2mL of 0.5 M EDTA, pH 8.0
* 990 mL glass-distilled or deionized water

Note: Adjust the volumes accordingly for specific needs.
2. Aliquot and autoclave the solutions.

3. Store at room temperature.

DNA quantification

Importance of Quantifying the amount of DNA in a sample before amplification allows you to

quantification determine whether or not sufficient DNA is present to permit amplification and to
calculate the optimum amount of DNA to add to the reaction. The optimum amount of
DNA for the Yfiler® Plus Kit is 1.0 ng in a maximum input volume of 10 uL for 30 PCR
cycles.

If too much DNA is added to the PCR reaction, then the increased amount of PCR
product that is generated can result in:

* Fluorescence intensity that exceeds the linear dynamic range for detection by the
instrument (“off-scale” data). Off-scale data are problematic because:

— Quantitation (peak height and area) for off-scale peaks is not accurate. For
example, an allele peak that is off-scale can cause the corresponding stutter
peak to appear higher in relative intensity, thus increasing the calculated
percent stutter.

— Multicomponent analysis of off-scale data is not accurate, and it results in
poor spectral separation (“pull-up”).

¢ Incomplete A-nucleotide addition.

When the total number of allele copies added to the PCR is extremely low, allelic
dropout can occur resulting in a partial profile.

Methods of Life Technologies provides several kits for quantifying DNA in samples. See the
quantifying DNA references cited in the following table for details about these Kkits.

20 Yfiler® Plus PCR Amplification Kit User Guide



Section 2.1 Amplification from extracted DNA
DNA quantification

Product

Description

Quantifiler® Human DNA
Quantification Kit
(Part no. 4343895)

and

Quantifiler® Y Human Male
DNA Quantification Kit
(Part no. 4343906)

For more information, see
Quantifiler® Human DNA
Quantification Kits User’s Manual
(Pub no. 4344790)

Quantifiler® Duo DNA
Quantification Kit
(Part no. 4387746)

For more information, see
Quantifiler® Duo DNA
Quantification Kit User's Manual
(Part no.4391294)

Quantifiler® HP DNA
Quantification Kit (Cat. no.
4482911)

For more information, see
Quantifiler HP and Trio DNA
Quantification Kits User Guide
(Pub no. 4485354)

Properties:

The Quantifiler® Human and Quantifiler® Y Human Male Kits are highly specific for
human DNA, and they individually detect total human or male DNA, respectively. The
kits detect single-stranded and degraded DNA.

How they work:

The Quantifiler® DNA Quantification Kits consist of target-specific and internal control
5' nuclease assays.

The Quantifiler® Human and Quantifiler® Y Human Male Kits contain different target-
specific assays (human DNA or human male DNA, respectively) that each consist of two
locus-specific PCR primers and one TagMan® MGB probe labeled with FAM™ dye for
detecting the amplified sequence. The kits each contain a separate internal PCR control
(IPC) assay, which consists of an IPC template DNA (a synthetic sequence not found in
nature), two primers for amplifying the IPC template, and one TagMan® MGB probe
labeled with VIC® dye for detecting the amplified IPC.

Properties:

The Quantifiler® Duo Kit is highly specific for human DNA. This kit combines the
detection of both total human and male DNA in one PCR reaction.The kit detects single-
stranded and degraded DNA.

How it works:

The Quantifiler® Duo DNA Quantification Kit consists of target-specific and internal
control 5' nuclease assays.

The Quantifiler® Duo kit combines two human-specific assays in one PCR reaction (for
total human DNA and human male DNA). The two human DNA specific assays each
consist of two PCR primers and a TagMan® probe. The TagMan® probes for the human
DNA and human male DNA assays are labeled with VIC® and FAM™ dyes, respectively.
In addition, the kit contains an internal PCR control (IPC) assay similar in principle to
that used in the other Quantifiler kits, but labeled with NED™ dye.

Properties:

The Quantifiler® HP Kit is designed to quantify the total amount of amplifiable human
DNA in a sample.

How it works:

The Quantifiler® HP DNA Quantification Kit uses multiple-copy target loci for improved
detection sensitivity. The human-specific target loci (Small Autosomal, Large
Autosomal, and Y-chromosome targets) each consist of multiple copies dispersed on
various autosomal chromosomes (Small Autosomal and Large Autosomal).

To maximize the consistency of quantification results, genomic targets were selected
with conserved primer- and probe-binding sites within individual genomes and also
with minimal copy number variability between different individuals and population
groups. As a result, the detection sensitivity of the assay is improved over Quantifiler®
Duo, Human, and Y Human Male DNA Quantification Kit assays. The primary
quantification targets (Small Autosomal and Y] consist of relatively short amplicons (75
to 80 bases) to improve the detection of degraded DNA samples. In addition, the kit each
contains a Large Autosomal target with a longer amplicon (>200 bases) to aid in
determining if a DNA sample is degraded.

Yfiler® Plus PCR Amplification Kit User Guide 21



2 Perform PCR
Prepare the amplification kit reactions

Product

Description

Quantifiler® Trio DNA
Quantification Kit (Cat. no.
4482910)

For more information, see
Quantifiler HP and Trio DNA
Quantification Kits User Guide
(Pub no. 4485354)

Properties:

The Quantifiler® Trio Kit is designed to simultaneously quantify the total amount of
amplifiable human DNA and human male DNA in a sample.

How it works:

The Quantifiler® Trio DNA Quantification Kit uses multiple-copy target loci for improved
detection sensitivity. The human-specific target loci (Small Autosomal, Large
Autosomal, and Y-chromosome targets) each consist of multiple copies dispersed on
various autosomal chromosomes (Small Autosomal and Large Autosomal), or multiple
copies on the Y-chromosome.

To maximize the consistency of quantification results, genomic targets were selected
with conserved primer- and probe-binding sites within individual genomes and also
with minimal copy number variability between different individuals and population
groups. As a result, the detection sensitivity of the assay is improved over Quantifiler®
Duo, Human, and Y Human Male DNA Quantification Kit assays. The primary
quantification targets (Small Autosomal and Y] consist of relatively short amplicons (75
to 80 bases) to improve the detection of degraded DNA samples. In addition, kits each
contain a Large Autosomal target with a longer amplicon (>200 bases) to aid in
determining if a DNA sample is degraded.
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Calculate the volume of each component needed to prepare the reactions, using
the table below.

DNA sample Volume per reaction
Yfiler® Plus Master Mix 10.0 L
Yfiler® Plus Primer Set 5.0 uL

Prepare reagents. Include additional reactions in your calculations to provide
excess volume for the loss that occurs during reagent transfers. Thaw the Master
Mix and the Primer Set, then vortex all reagent tubes, including the enzyme, for
3 seconds and centrifuge briefly before opening the tubes.

IMPORTANT! Thawing is required only during first use of the Primer Set and
Master Mix. After first use, these reagents are stored at 2 to 8°C and, therefore,
they do not require subsequent thawing. Do not refreeze these reagents.

. Prepare the reaction mixture: Pipette the required volumes of components into an

appropriately sized polypropylene tube.

Vortex the reaction mixture for 3 seconds, then centrifuge briefly.

. Dispense 15 pL of the reaction mixture into each reaction well of a MicroAmp®

Optical 96-Well Reaction Plate or each MicroAmp® tube.

. Prepare the DNA samples:
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Perform PCR

Section 2.1 Amplification from extracted DNA
Perform PCR

DNA sample To prepare...

Negative control | Add 10 pL of low-TE buffer (10mM Tris, 0.1mM EDTA, pH 8.0).

Test sample Dilute a portion of the test DNA sample with low-TE buffer so
that 1.0 ng of total DNA is in a final volume of 10 uL. Add 10 pL
of the diluted sample to the reaction mix.

Positive control Add 007 control DNA to a total amount of 1.0 ng.

The final reaction volume (sample or control plus reaction mixture) is 25 pL.

. Seal the plate with MicroAmp® Clear Adhesive Film or MicroAmp® Optical

Adhesive Film, or cap the tubes.

. Centrifuge the tubes at 3000 rpm for about 20 seconds in a tabletop centrifuge

(with plate holders if using 96-well plates).

. Amplify the samples in a GeneAmp® PCR System 9700 with the silver or

gold-plated silver 96-well block or a Veriti® 96-Well Thermal Cycler.

Note: The Yfiler® Plus Kit is not validated for use with the GeneAmp PCR System
9700 with the aluminium 96-well block. Use of this thermal cycling platform may
adversely affect performance of the Yfiler® Plus Kit.

. Program the thermal cycling conditions:

* When using the GeneAmp® PCR System 9700 with either 96-well silver or
gold-plated silver block, select the 9600 Emulation Mode.

e When using the Veriti® 96-Well Thermal Cycler, refer to the following
document for instructions on how to configure the Veriti instrument to run
in the 9600 Emulation Mode: User Bulletin: Veriti® 96-Well Thermal Cycler
AmpF(STR® Kit Validation (Part no.4440754).

Initial incubation step Denature Anneal/ Final Final hold
Extend extension
HOLD CYCLE (30) HOLD HOLD
95°C 94°C 61.5°C 60°C 4°C o
1 min 4 sec Tmin 22 min

. Load the plate into the thermal cycler and close the heated cover.

IMPORTANT! If using the 9700 thermal cycler with silver or gold-plated silver
block and adhesive clear film instead of caps to seal the plate wells, be sure to
place a MicroAmp® compression pad (Part no. 4312639) on top of the plate to
prevent evaporation during thermal cycling. The Veriti® Thermal Cycler does not
require a compression pad.

. Start the run.

. On completion of the run, store the amplified DNA and protect from light.
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Perform PCR
Perform PCR

If you are storing the DNA... Then place at...
< 2 weeks 2 to 8°C
> 2 weeks -15to -25°C

IMPORTANT! Store the amplified products so that they are protected from light.
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Section 2.2 Direct amplification of DNA
Optimize PCR cycle number

Section 2.2 Direct amplification of DNA

Optimize PCR cycle number

Select samples and
prepare plates

Before using the Yfiler® Plus Kit for the first time, perform a single initial sensitivity
experiment to determine the appropriate cycle number to use during internal
validation studies and operational use of the Yfiler® Plus Kit. This experiment
accounts for instrument-to-instrument and sample-to-sample variations. If you are
processing multiple sample type and substrate combinations (for example, buccal
samples on treated paper and blood samples on untreated paper), perform separate
sensitivity experiments for each sample type and substrate to be used for testing.

The Yfiler® Plus Kit is optimized to amplify unpurified:

¢ Single-source blood samples on treated paper

* Buccal samples on treated paper substrates without the need for sample
purification

¢ Blood samples collected on untreated paper with the addition of Prep-n-Go™
Buffer

* Buccal samples collected on swab substrates and treated with Prep-n-Go™ Buffer

When amplifying single-source, unpurified samples using the Yfiler® Plus Kit, you
should expect to see greater variation in peak height from sample to sample than is
expected with purified samples. Careful optimization of the cycle number will help to
minimize the impact of this variation.

1. Select 20 of each sample and substrate type. Ensure the selected samples represent
a “typical” range of samples analyzed in your laboratory.

IMPORTANT! The number of samples recommended for this study has been
chosen to allow you to complete electrophoresis using a single 96-well plate, thus
minimizing the impact of run-to-run variation on the results.

2. Prepare the samples and the reactions as described in the protocols later in this
chapter. Prepare sufficient PCR reagents to complete amplification of three
replicate plates.

3. Create three identical PCR plates.
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Treated or untreated paper: prepare reactions

Determine
optimum
conditions

4. Amplify each plate using a different cycle number to determine the optimum

conditions for use in your laboratory. Suggested cycle numbers for different
sample type and substrate combinations are listed below:

Substrate

Sample type
Treated or untreated paper

Blood 26, 27, 28, 29 cycles

Buccal 26, 27, 28, 29 cycles

Note: To minimize the effect of instrument-to-instrument variation, use the same
thermal cycler to amplify all three plates. To maximize result quality, prepare and
amplify Plate 1 then repeat for Plates 2 and 3. Do not prepare all three plates
simultaneously.

. Run the PCR products on the appropriate CE platform using the recommended

protocol; see Chapter 3, “Perform electrophoresis” on page 33.

. Based on the results of the sensitivity study, select the appropriate PCR cycle

number for future experiments.

Our studies indicate the optimum PCR cycle number should generate profiles with the
following peak heights, with no instances of allelic dropout and minimal occurrence of
off-scale allele peaks.

Instrument Peak height
31xx 2500-4000 RFU
3500 Series 5000-12,000 RFU

Treated or untreated paper: prepare reactions

Sample prep
guidelines

26

Do not add water to the wells on the reaction plate before adding the punches. If
your laboratory is experiencing static issues with the paper discs, you may
prepare and dispense the 25 uL reaction mix into the wells of the reaction plate
before adding the punches.

For manual punching: Place the tip of a 1.2 mm Harris Micro-Punch on the card,
hold the barrel of the Harris Micro-Punch (do not touch the plunger), gently press
and twist 1/4-turn, then eject the punch into the appropriate well on the reaction
plate.

For automated punching: Please refer to the User Guide of your automated or
semi-automated disc punch instrument for proper guidance.

For blood on untreated paper samples, add 2 pL of Prep-n-Go™ buffer on top of
the 1.2-mm sample punch.
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Prepare the

reactions

Section 2.2 Direct amplification of DNA

Treated or untreated paper: prepare reactions

. Add samples to the reaction plate:

Add the following to wells of a MicroAmp®

Wellls) Optical 96-Well Reaction Plate
Negative control 1.2 mm blank disc
Test samples 1.2 mm sample disc
Positive control e For 26 cycles 3 pL of Control DNA 007
IMPORTANT! Do not add a e For 27 cycles 2 pL of Control DNA 007
blank disc to the positive e For 28 cycles 1 uL of Control DNA 007
control well.

e For 29 cycles 1 pL of Control DNA 007

Note: The volumes of positive control are suggested amounts and may be adjusted if
peak heights are too high or too low for your optimized cycle number.

. Calculate the volume of each component needed to prepare the reactions, using

the table below.
Reaction component Volume per reaction
Master Mix 10.0 pL
Primer Set 50pL
PCR Low TE buffer 10.0 pL

Note: Include additional reactions in your calculations to provide excess volume
for the loss that occurs during reagent transfers.

IMPORTANT! This kit has been optimized for a 25-uL PCR reaction volume to
overcome the PCR inhibition expected when amplifying unpurified samples.
Using a lower PCR reaction volume may reduce the ability of the kit chemistry to
generate full STR profiles.

. Prepare reagents. Thaw the Master Mix and Primer Set, then vortex for 3 seconds.

Centrifuge briefly before opening the tubes or bottles.

IMPORTANT! Thawing is required only during first use of the kit. After first use,
reagents are stored at 2 to 8°C and, therefore, do not require subsequent thawing.
Do not refreeze the reagents.

. Pipet the required volumes of components into an appropriately sized

polypropylene tube.

. Vortex the reaction mix for 3 seconds, then centrifuge briefly.

. Dispense 25 uL of the reaction mix into each reaction well of a MicroAmp®

Optical 96-Well Reaction Plate.

Yfiler® Plus PCR Amplification Kit User Guide 27



Swab substrates: prepare reactions

7.

Swab substrates:

Sample prep .
guidelines .

Prepare the 1.
sample lysate

(room temperature 2
protocol)

Seal the plate with MicroAmp® Clear Adhesive Film or MicroAmp® Optical
Adhesive Film.

IMPORTANT! If using the 9700 thermal cycler with silver or gold-plated silver
block and adhesive clear film instead of caps to seal the plate wells, place a
MicroAmp® compression pad (Cat. no. 4312639) on top of the plate to prevent
evaporation during thermal cycling. The Veriti® Thermal Cycler does not require
a compression pad.

Centrifuge the plate at 3000 rpm for about 20 seconds in a tabletop centrifuge
with plate holders.

prepare reactions

Detach each buccal swab head from the swab shaft before lysis.

If using the heated lysis protocol, perform lysis in either of the following formats:

— 1.5 mL tubes with a heat block (VWR® Scientific Select dry heat block or
similar)

— 96-well deep-well plate (Part no. 4392904) with an oven and a metal plate
adaptor (Robbins Scientific® Model 400 Hybridization Incubator or similar,
Agilent® Benchtop Rack for 200 pl Tubes/V Bottom Plates (metal)

Part no. 410094 or similar)

IMPORTANT! Do not use a plastic plate adaptor.

For optimum performance, lysis of a whole swab is recommended. To preserve
the sample, evaluate lysis of a half swab.

Add 400 puL Prep-n-Go" Buffer (Part no. 4471406) to 1.5 mL tubes or the
appropriate wells of a 96-well deep-well plate (Part no. 4392904).

. Into each tube or well, put the entire head of each swab and let stand for

20 minutes at room temperature (20 to 25°C) to lyse the sample.

After 20 minutes, transfer the sample lysate out of the sample plate into tubes or
plates for storage, then discard the deep-well plate containing the swab heads.

Note: To minimize the risk of contamination, do not remove the swab heads from
the sample lysate plate before transferring the lysate.

Proceed to “Prepare the reactions” on page 29 or see “Store the sample lysate” on
page 31.

Prepare the This protocol may improve the performance for challenging or aged samples.

sample lysate (heat

protocol)
2.

28

. Preheat the heat block to 90°C or the oven with metal plate adaptor to 99°C.

Add 400 uL Prep-n-Go" Buffer (for buccal swabs, Part no. 4471406) to 1.5 mL
tubes or the appropriate wells of a 96-well deep-well plate (Part no. 43929040).
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Section 2.2 Direct amplification of DNA

Swab substrates: prepare reactions

3. Into each tube or well, put the entire head of each swab. If you are using tubes,
cap the tubes. Let the tubes or plate stand for 20 minutes in the preheated heat
block or oven to lyse the sample.

4. After 20 minutes, remove the tubes or the deep-well plate from the heat block or
oven.

5. Let the lysate stand at room temperature for at least 15 minutes to cool the lysate
(for accurate pipetting).

6. Transfer the sample lysate out of the 1.5 mL tubes or sample plate into tubes or
plates for storage, then discard the 1.5 mL tubes or deep-well plate containing the
swab heads.

Note: To minimize the risk of contamination, do not remove the swab heads from
the sample lysate plate before transferring the lysate.

7. Proceed to the next section to prepare the reactions or see “Store the sample

lysate” on page 31.

Prepare the 1. Add Prep-n-Go'" Buffer (Part no. 4471406) to the control wells in the reaction
reactions plate:

Add the following to wells of a MicroAmp® Optical

Wellls) 96-Well Reaction Plate...

Negative control 3 uL of Prep-n-Go™ Buffer

Positive control e For 25 and 26 cycles = 0L of Prep-n-Go™ Buffer
 For 27 cycles 1 L of Prep-n-Go™ Buffer
e For 28 cycles 2 uL of Prep-n-Go™ Buffer

2. Prepare reagents:

a. Thaw the Master Mix, and Primer Set, then vortex for 3 seconds and
centrifuge briefly before opening the tubes or bottles.

IMPORTANT! Thawing is required only during first use of the kit. After first
use, reagents are stored at 2 to 8°C and, therefore, do not require subsequent
thawing. Do not refreeze the reagents.
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Swab substrates: prepare reactions

30

3. Calculate the volume of each component needed to prepare the reactions using

the table below.
Reaction component Volume per reaction
Master Mix 10.0 L
Primer Set 5.0 L
PCR Low TE Buffer 10.0 uL

Note: Include additional reactions in your calculations to provide excess volume
for the loss that occurs during reagent transfers.

IMPORTANT! This kit has been optimized for a 25-uL PCR volume to overcome
the PCR inhibition expected when amplifying unpurified samples. Using a lower
PCR volume may reduce the ability of the kit chemistry to generate full STR
profiles.

. Pipet the required volumes of components into an appropriately sized

polypropylene tube.

. Vortex the reaction mix for 3 seconds, then centrifuge briefly.

. Dispense 25 uL of the reaction mix into each reaction well of a MicroAmp®

Optical 96-Well Reaction Plate. The final volume in each well is 28 pL (reaction
mix plus Prep-n-Go™ Buffer and sample lysate or positive control).

Note: For samples and controls, add 3 pL of lysate, or the 1-, 2-, or 3 uL of control
DNA in addition to the 25 uL of reaction mix. There is no need to compensate for
the volume of lysate/control.

. Add samples to the reaction plate:

Add the following to wells of a MicroAmp® Optical

Wellls) 96-Well Reaction Plate...

Test samples 3 pL of sample lysate

Positive control e For 25 and 26 cycles = 3 pL of Control DNA 007
e For 27 cycles 2 pL of Control DNA 007
e For 28 cycles 1 pL of Control DNA 007

Note: The volumes of positive control are suggested amounts and may be adjusted
if peak heights are too high or too low for your optimized cycle number.

The final volume in each well is 28 pL (reaction mix plus Prep-n-Go"" Buffer and
sample lysate or positive control).

. Seal the plate with MicroAmp® Clear Adhesive Film or MicroAmp® Optical

Adhesive Film.

IMPORTANT! We recommend adhesive film for plate sealing to provide a
consistent seal across all wells and prevent evaporation. Do not use caps, which
may not provide a consistent seal across all wells.
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Store the sample
lysate

Perform PCR

Section 2.2 Direct amplification of DNA
Perform PCR

IMPORTANT! If using the 9700 thermal cycler with silver or gold-plated silver
block, place a MicroAmp® compression pad (Part no. 4312639) on top of the plate
to additionally prevent evaporation during thermal cycling. The Veriti® Thermal
Cycler does not require a compression pad.

9. Vortex the reaction mix at medium speed for 3 seconds.

10. Centrifuge the plate at 3000 rpm for about 20 seconds in a tabletop centrifuge
with plate holders.

11. Amplify the samples in a Veriti® 96-well Thermal Cycler or PCR System 9700
with the silver or gold-plated silver 96-well block as described in “Perform PCR”
on page 31.

Cap the sample lysate storage tubes or seal the sample lysate storage plate with
MicroAmp® Clear Adhesive Film.

Store the sample lysate as needed:

Then place at...

2to 8°C
-15 to -25°C

If you are storing the sample lysate...

<2 weeks

>2 weeks

These storage recommendations are preliminary pending the results of ongoing
stability studies. The effects of multiple freeze-thaw cycles on the lysate have not been
fully evaluated. Therefore, multiple freeze-thaw cycles are not recommended.

1. Program the thermal cycling conditions.

*  When using the GeneAmp® PCR System 9700 with either 96-well silver or
gold-plated silver block, select the 9600 Emulation Mode.

* When using the Veriti® 96-Well Thermal Cycler, refer to the following
document for instructions on how to configure the Veriti instrument to run
in the 9600 Emulation Mode: User Bulletin: Veriti® 96-Well Thermal Cycler
AmpFSTR® Kit Validation (Part no. 4440754).

Initial incubation Denature Anneal/Extend Flna! Final hold
step Extension
HOLD CYCLE (26-29) HOLD HOLD
95°C 94°C 61.5°C 60.0°C 4°C
1 min 4 sec 1 min 22 min oo
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Perform PCR

2. Load the plate into the thermal cycler and close the heated cover.

IMPORTANT! If using the 9700 thermal cycler with silver or gold-plated silver
block and adhesive clear film instead of caps to seal the plate wells, be sure to
place a MicroAmp® compression pad (Cat. no. 4312639) on top of the plate to
prevent evaporation during thermal cycling. The Veriti® Thermal Cycler does not
require a compression pad.

. Start the run.

. On completion of the run, store the amplified DNA and protect from light.

If you are storing the DNA... Then place at...
<2 weeks 2 to 8°C
>2 weeks -15to -25°C

IMPORTANT! Store the amplified products so that they are protected from light.
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Perform electrophoresis
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Allelic ladder requirements

To accurately genotype samples, you must run an allelic ladder sample along with the
unknown samples.

Number of One -
. L Number of samples per allelic
Instrument allelic ladders injection
ladder(s)

to run equals
3500 1 per 3 injections | 8 samples 23 samples + 1 allelic ladder
3500xL 1 per injection 24 samples 23 samples + 1 allelic ladder
3130 1 per 4 injections | 4 samples 15 samples + 1 allelic ladder
3130x( 1 per injection 16 samples 15 samples + 1 allelic ladder

IMPORTANT! Variation in laboratory temperature can cause changes in fragment
migration speed and sizing variation between both single- and multiple-capillary runs
(with larger size variations seen between samples injected in multiple-capillary runs).
We recommend the above frequency of allelic ladder injections, which should account
for normal variation in run speed. However, during internal validation studies, verify
the required allelic ladder injection frequency to ensure accurate genotyping of all
samples in your laboratory environment.

It is critical to genotype using an allelic ladder run under the same conditions as the
samples, because size values obtained for the same sample can differ between
instrument platforms because of different polymer matrices and electrophoretic
conditions.
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Section 3.1 3500/3500xL instruments

Set up the 3500/3500xL instruments for electrophoresis

Reagents and parts Appendix C, “Ordering information” on page 109 lists the required materials not
supplied with this kit.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect
the primer set, amplified DNA, allelic ladder, and size standard from light when not in
use.

Do not refreeze kit components after thawing.
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Section 3.1 3500/3500xL instruments
Set up the 3500/3500xL instruments for electrophoresis

Electrophoresis The following table lists data collection software and the run modules that you can use
software setupand o analyze PCR products generated by this kit. For details on the procedures, refer to
reference the documents listed in the table.
documents
. . Data . Plate templates, assays, run
fnzr:e:'ecr Oge;taet::g Collection A:l"::u:::l modules, and conditions References
¥ y Software (installed with the HID Updater)
35008 Windows 3500 Data | HIDUpdater | o Plate templates: 6dye_36_POP4 3500/3500xL Genetic
Vista® Collection 3500 DC e Assays: GF+Norm_POP4 and Analyzer User Guide
Software v2.0 GF_POP4 which contain instrument  (Pub. no. 4401661)
v2.0 (Part no. protocol HID36_POP4_J6_NT3200  Hip Updater 3500 Data
4480670] with the following conditions: Collection Software v2
- Run module: HID36_POP4 Release Notes
- Injection conditions:
1.2 kV/16 sect
- Alternate injection conditions:
1.5 kV/16 sect
- Run conditions: 13 kV/1550 sec
- Dye Set J6
3500xL8 e Plate templates: 6dye_36_POP4_xl
e Assays: GF+Norm_POP4_xl and
GF_POP4_xl which contain
instrument protocol
HID36_POP4xl_J6_NT3200 with the
following conditions:
- Run module: HID36_POP4xl
- Injection conditions: 1.2 kV/24 sec
- Alternate injection conditions:
1.5 kV/24 sectt
- Run conditions: 13 kV/1550 sec
- Dye Set J6
35008 Windows® 7 3500 Data  HID Updater Same as 3500 Data Collection Software ' 3500/3500xL Genetic
3500xL5 Collection 3500 DC v2.0 listed above Analyzer User Guide
Software v2.0 (Pub. no. 4476988)
v2.0 Z%g 638.] HID Updater 3500 Data
Collection Software v2
Release Notes

T This kit was developed using an injection time of 16 seconds on the 3500 instrument. This is different than the default injection time of 15 seconds.
The instrument protocol will need to be modified accordingly.

1 This kit was developed using two injection voltage conditions for the 3500 instrument; 1.2 kV/16 sec and 1.5 kV/16 sec. You are encouraged to
explore both options during validation to determine which protocol provides the best results on your instrumentation.
§ We conducted validation studies for the Yfiler® Plus Kit using the 3130x(, 3500, or 3500xL configurations.

11 This kit was developed using two injection voltage conditions for the 3500xL instrument; 1.2 kV/24 sec and 1.5 kV/24 sec. You are encouraged to
explore both options during validation to determine which protocol provides the best results on your instrumentation.
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3 Perform electrophoresis
Set up the 3500/3500xL instruments for electrophoresis

Obtain and run the
HID Updater

Create a Yfiler
Plus® assay

Modify 3500 QC
protocol size-
calling method

36

You can run 6-dye samples on 3500 Data Collection Software v1 or v2. Before running
on either system for the first time, run the HID Updater 3500 DC v2.0

(Part no. 4480670). The HID Updater installs plate templates, assays, and instrument
protocols that can be used to run Yfiler® Plus Kit samples. For more information, refer
to the release notes provided with the Updater.

Note: If you have a new instrument installed by a Life Technologies representative, the
updater may have been run during installation.

1. Shut down the 3500/3500xL Data Collection Software.

2. Download the updater from www.lifetechnologies.com/support » Software,
Patches & Updates » 3500 Series Genetic Analyzers for Human
Identification » HID Updater 3500 DC v2.0.

Click on the Read me file to review the software release notes.
Click on the updater .exe file.

Follow the on-screen prompts.

AN AN S

Restart the computer.

The Yfiler® Plus assay will have an instrument protocol and a QC protocol. The easiest
way to create an assay is to start off with an existing one that can be modified
independently. To modify an existing assay:

1. Access the Assays library by selecting the Library tab and then the Assays tab
under Library Resources.

2. Select an existing assay (i.e. GF_POP4), click duplicate and give it a new name (i.e.
YFP_POP4).

3. Select the new assay and then click Edit to open it.

4. Open the instrument protocol by clicking on Edit and modify the injection and
run conditions specific to your instrument class and as shown on the table on
page 35. Save the modified instrument protocol by clicking on Save to Library
and give the protocol a new name.

5. Follow the instructions below to edit the QC protocol.
The Yfiler® Plus Kit has been validated with data that was analyzed using the Local
Southern method (60460 base pairs). The QC protocol provided in the HID assay

installed by the HID Updater 3500 DC v2.0 is set for the 3rd Order Least Squares
method. To use the Local Southern method for fragment sizing, edit the QC protocol:

1. In the Library tab, open the QC Protocol window.
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www.lifetechnologies.com/support

Section 3.1 3500/3500xL instruments 3
Set up the 3500/3500xL instruments for electrophoresis

2. Create a new QC protocol according to the figure:

i Setup & QC Protocol @ .

| * Protocol Name i | Locked [
| Description:

SizeStandard: | GS600_LIZ.{60-460) - <« '
| Saccoter [SaeCaller 10 =] .

| Analysis Settings I QC Settings |

|
‘ @
‘ Analysis Range: Full = Sizing Range: LP_lrEjul__'] < Size Calling Method: |l al Southern _;
| Analysis Start Point: | O Sizing Stant Size: 60 S

|

| Analysis Stop Point: | 1000000 Sizing Stop Size: 460 ——

|

| | /| Blue 7| Green [7] Yellow v Red v Purple Orange

| Peak Amplitude Threshold 175 175 175 175 175 175

|

Commeon Settings

Use Smoothing | [Light  ~|

: Use Baselining (Baseline Window (Pts)) | ] 33 . <
| Minimurm Peak Half Width 2 |
| Peak Window Size | 13 | I
Polynomial Degree | 3 T |
Slope Threshold Peak Start | 00

Slope Threshold Peak End 1]

a. Name the new QC protocol according to your laboratory’s standard
convention.

b. Set the following parameters:

Parameter Setting
Size Standard GS600_LIZ_(60-460)
Size Range Partial
Sizing Start Size 60 bp
Sizing Stop Size 460 bp
Size Calling Method " Local Southern Method
After checking the “Use Baselining” box:
Baseline Window Pts. 33
Peak Window Size 13

c. Click Save.
3. Add the QC protocol to the HID assay.
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3 Perform electrophoresis
Prepare samples for electrophoresis on the 3500/3500xL instruments

Perform spectral Perform a spectral calibration using the DS-36 Matrix Standard (J6 Dye Set)
calibration (Part no. 4425042). The following figure is an example of a passing 6-dye spectral
calibration.
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Prepare samples for electrophoresis on the 3500/3500xL
instruments

Prepare the samples for electrophoresis immediately before loading.

1. Calculate the volume of Hi-Di™ Formamide and GeneScan™ 600 LIZ® Size
Standard v2.0 needed to prepare the samples:

Reagent Volume per reaction
GeneScan™ 600 LIZ® Size Standard v2.0 0.4 L
Hi-Di™" Formamide 9.6 uL

Note: Include additional samples in your calculations to provide excess volume
for the loss that occurs during reagent transfers.

IMPORTANT! The volume of size standard indicated in the table is a suggested
amount. Determine the appropriate amount of size standard based on your
experiments and results.

2. Pipet the required volumes of components into an appropriately sized
polypropylene tube.

3. Vortex the tube, then centrifuge briefly.
4. Into each well of a MicroAmp® Optical 96-Well Reaction Plate, add:

* 10 pL of the formamide:size standard mixture
* 1 uL of PCR product or Allelic Ladder
Note: For blank wells, add 10 pL of Hi-Di"" Formamide.
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Section 3.1 3500/3500xL instruments

Prepare samples for electrophoresis on the 3500/3500xL instruments

5. Seal the reaction plate with appropriate septa, then briefly vortex and centrifuge
the plate to ensure that the contents of each well are mixed and collected at the
bottom.

Heat the reaction plate in a thermal cycler for 3 minutes at 95°C.
Immediately place the plate on ice for 3 minutes.

Place the plate assembly on the autosampler.

©® ® N o

Start the electrophoresis run.
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3 Perform electrophoresis
Prepare samples for electrophoresis on the 3500/3500xL instruments
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Set up the 3130/3130x! instruments for electrophoresis

Section 3.2 3130/3130x( instruments

Set up the 3130/3130x( instruments for electrophoresis

Reagents and parts Appendix C, “Ordering information” on page 109 lists the required materials not
supplied with this kit.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect
the primer set, amplified DNA, allelic ladder, and size standard from light when not in
use.

Do not refreeze kit components after thawing.

Electrophoresis The following table lists data collection software and the run modules that can be used
software setupand  t° analyze PCR products generated by this kit. For details on the procedures, refer to
the documents listed in the table.

reference
documents
Genetic Operatin Data Additional
P 9 | Collection Run modules and conditions References
Analyzer System software
Software
3130 -or- | Windows® Data 3130/3730 DC e« HIDFragmentAnalysis36_POP4_1 | Applied Biosystems
3130)([1- 7 Collection A 6—Dye |njecti0n conditions for 3130: 3130 Series Data
Software = Module v1 3 kV/5 sec Collection Software v4
vh (contact Life Getting Started Guide

Injection conditions for 3130x:
Technologies) A KV10 s T (Pub. no. 4477796)

Alternate injection conditions for

the 3130xt: 3 kV/13 sect

Run conditions: 15 kV/1500 sec
e Dye Set J6

t We conducted validation studies for the Yfiler® Plus Kit using the 3130x{, 3500, or 3500xL configurations.

1 This kit was developed using two injection voltage conditions for the 3130x(; 3 kV/10 sec and 3 kV/13 sec. You are encouraged to explore both
options during validation to determine which protocol provides the best results on your instrumentation.

Obtain and activate 1. Confirm that you are running Data Collection Software v4 (Help » About).

the 6'd¥e license 2. Obtain a 3130 DC v4 6-Dye Module v1 License key. Contact Life Technologies for
for the instrument information.

3. Ensure that all network cards in the computer are enabled.

IMPORTANT! You can run the 3130 Series Data Collection Software v4 using only
the network cards enabled when you activate the software license. For example, if
you activate the software when your wireless network card is disabled, you will
not be able to run the software when the wireless network card is enabled.
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4. Select Tools » License Manager to display the Software Activation dialog box.

3w Series Data Collection Software 4 Software Activation

i

1. Request license file for Computer ID:

002554ee13a4 002564ee13a5

b. Enter your email address:

john,doe@lifetech, com

This ID i= unigue fo this computer and cannot be used fo obtain 3 license file for another computer.

a. Enter the license key (from CD or email):

AID-166c-9aaf-030c-462e-2163-974c-e607-1236

c. Is this computer currently connected to the internet?

Yes., Connected. | | MNo. Mot Connected.

3. Find the license file:

2. Retrieve the license file from email, then save it to the desktop of this computer.

Browse...

4. Click Install and Validate License

Close

Request the software license file by performing steps 1a, 1b, and 1c as listed on

the activation screen. The license file will be emailed to you.

computer.

10.
11.

installed and validated.

12. Click Close.

42

Obtain the software license file from your email.
Make a copy of the software license file and keep in a safe location.

Copy the software license file to the desktop of the Data Collection Software v4

If the Software Activation dialog box has closed, select Tools » License Manager.
Click Browse, then navigate to the software license file saved on your computer.

Click Install and Validate License. A message is displayed when the license is
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Section 3.2 3130/3130xl instruments

Prepare samples for electrophoresis on the 3130/3130x( instruments

Perform spectral Perform a spectral calibration using the DS-36 Matrix Standard (J6 Dye Set)
calibration (Part no. 4425042). The following figure is an example of a passing 6-dye spectral
calibration.
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Prepare samples for electrophoresis on the 3130/3130x!
instruments

Prepare the samples for electrophoresis immediately before loading.

1. Calculate the volume of Hi-Di"" Formamide and size standard needed to prepare
the samples:

Reagent Volume per reaction
GeneScan™ 600 LIZ® Size Standard v2.0 0.4 pL
Hi-Di™ Formamide 9.6 uL

Note: Include additional samples in your calculations to provide excess volume
for the loss that occurs during reagent transfers.

IMPORTANT! The volume of size standard indicated in the table is a suggested
amount. Determine the appropriate amount of size standard based on your
experiments and results.

2. Pipet the required volumes of components into an appropriately sized
polypropylene tube.

3. Vortex the tube, then centrifuge briefly.
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Prepare samples for electrophoresis on the 3130/3130x! instruments

4. Into each well of a MicroAmp® Optical 96-Well Reaction Plate, add:
® 10 pL of the formamide:size standard mixture
¢ 1 pL of PCR product or Allelic Ladder
Note: For blank wells, add 10 puL of Hi-Di™ Formamide.

5. Seal the reaction plate with appropriate septa, then briefly vortex and centrifuge
the plate to ensure that the contents of each well are mixed and collected at the
bottom.

Heat the reaction plate in a thermal cycler for 3 minutes at 95°C.
Immediately place the plate on ice for 3 minutes.

Place the plate assembly on the autosampler.

Y ® N o

Start the electrophoresis run.
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Analyze Data

Overview of GeneMapper® ID-X Software v1.4 ...........ooiiuienanao... 45
Set up GeneMapper® ID-X Software for data analysis. ..................... 47
Analyze and edit sample files with GeneMapper® ID-X Software. ........... 59
Examine and edita project ......... ... ... i 60
For more information. ........... ... ... i 61

Overview of GeneMapper® ID-X Software v1.4

GeneMapper® ID-X Software v1.4 or higher analyzes 4-dye, 5-dye, and 6-dye data and
is required to correctly analyze data generated using the Yfiler® Plus Kit. After
electrophoresis, the data collection software stores information for each sample in a
fsa or .hid file. Using GeneMapper® ID-X Software v1.4 or higher enables you to
analyze and interpret the data from the .fsa or .hid files.

Instruments Refer to “Instrument and software overview” on page 15 for a list of compatible
instruments.
Before you start When using GeneMapper® ID-X Software v1.4 or higher to perform human

identification (HID) analysis with Yfiler® Plus kits, be aware that:

¢ HID analysis requires at least one allelic ladder sample per run folder. Your
laboratory can use multiple ladder samples in an analysis, provided individual
laboratories conduct the appropriate validation studies.

For multiple ladder samples, the GeneMapper® ID-X Software calculates allelic
bin offsets by using an average of all ladders that use the same panel within a run
folder.

¢ Allelic ladder samples in an individual run folder are considered to be from a
single run.

When the software imports multiple run folders into a project, only the ladder(s)
within their respective run folders are used for calculating allelic bin offsets and
subsequent genotyping.

¢ Allelic ladder samples must be labeled as “Allelic Ladder” in the Sample Type
column in a project. Failure to apply this setting for ladder samples results in
failed analysis.
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4 Analyze Data
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* Injections containing the allelic ladder must be analyzed with the same analysis
method and parameter values that are used for samples to ensure proper allele
calling.

e Alleles that are not in the Yfiler® Plus Allelic Ladders do exist. Off-ladder (OL)
alleles may contain full and/or partial repeat units. An off-ladder allele is an allele
that occurs outside the +0.5-nt bin window of any known allelic ladder allele or
virtual bin.

Note: If a sample allele peak is called as an off-ladder allele, the sample result
needs to be verified according to the laboratory’s protocol.
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Set up GeneMapper® ID-X Software for data analysis

Panel, bin, and The file names shown in this section may differ from the file names you see when you

stutter file version  download or import files. If you need help determining the correct files to use, contact
your local Life Technologies Human Identification representative, or go to
www.lifetechnologies.com/support » Software, Patches & Updates » GeneMapper®
ID-X Software.

The instructions and examples in this section refer to the latest version of panel, bin,
and stutter file available at the time of publication.

Before using the Before you use GeneMapper® ID-X Software v1.4 to analyze data for the first time, you
software for the must do the fOHOWiI‘lgI
first time 1. Check www.lifetechnologies.com/support » Software, Patches &

Check panel, bin,
and stutter file
version

-_—

Updates » GeneMapper® ID-X Software to obtain the latest Yfiler® Plus Kit panel,
bin, and stutter files.

Download and import the files into the GeneMapper® ID-X Software, as
explained in “Import panels, bins, and marker stutter” on page 48.

Note: When downloading new versions of analysis files, refer to the associated
Read Me file for details of changes between software file versions. If you have
validated previous file versions for data analysis, conduct the appropriate
internal verification studies before using new file versions for operational
analysis.

Create an analysis method, as explained in “Create an analysis method” on page
52.

Define custom views of analysis tables.
Refer to Chapter 1 of the GeneMapper® ID-X Software Version 1.0 Getting Started
Guide (Pub no. 4375574) for more information.

Define custom views of plots.

Refer to Chapter 1 of the GeneMapper® ID-X Software Version 1.0 Getting Started
Guide (Pub no. 4375574) for more information.

Start the GeneMapper® ID-X Software, then log in with the appropriate user
name and password.

IMPORTANT! For logon instructions, refer to the GeneMapper® ID-X Software
Version 1.0 Getting Started Guide (Pub no. 4375574).

Select Tools » Panel Manager.

Check the version of files imported into the Panel Manager:

»* Panel Manager

a. Select Panel Manager in the navigation pane. Fl= Edt Bns View Help

Lal

% .-, Panel Manager
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4 Analyze Data
Set up GeneMapper® ID-X Software for data analysis

b. Expand the Panel Manager folder and any sub-folders to identify the
analysis file version already installed for your kit choice.

4. Check the version of files available for import into the Panel Manager:

a. Select Panel Manager, then select File » Import Panels to open the Import
Panels dialog box.

b. Navigate to, then open the Panels folder and check the version of panel, bin,
and stutter files installed.

5. If newer versions are available on the website, download and import as described
below.

Import panels, To import the latest Yfiler® Plus Kit panel, bin set, and marker stutter files from our
bins, and marker web site into the GeneMapper® ID-X Software database:
stutter 1. Download and open the file containing panels, bins, and marker stutter:

a. Go to www.lifetechnologies.com/support » Software, Patches &
Updates » GeneMapper® ID-X Software. Download the file Yfiler Plus
Analysis files_v1X or its latest version.

b. Unzip the file.

2. Start the GeneMapper® ID-X Software, then log in with the appropriate user
name and password.

IMPORTANT! For logon instructions, refer to the GeneMapper® ID-X Software
Version 1.0 Getting Started Guide (Pub. no. 4375574).

3. Select Tools » Panel Manager.

4. Find, then open the folder containing the panels, bins, and marker stutter:

a. Select Panel Manager in the navigation pane.

b. Select File » Import Panels to open the Import »* Panel Manager
Panels dialog box. File  Edit

Eins Wiew H

c. Navigate to, then open the Yfiler Plus Analysis
files_v1X folder that you unzipped in step 1 on
page 48.
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5. Select Yfiler_Plus_Panels_v1.txt (or the version you installed), then click Import.

Note: Importing this file creates a new folder in the navigation pane of the Panel
Manager “Yfiler_Plus_Panels_v1”. This folder contains the panel for the Yfiler®
Plus Kit and associated markers.

-

-
J-' Import Panels M

Look in: [ | Yfiler Plus Analysis files_v1X = ? “E

| Yfiler_Plus_Bins_v1.tet

e
&j B Vfiler Plus_Panels v1.t¢t

Recent Items | Yfiler_Plus_Stutter_vl.bt

Desktop File name: Yfiler_Plus_Panels_v1.txt

6. Import Yfiler Plus_Bins_v1.txt:

a. Select the Yfiler_Plus_Panels_v1 folder in the navigation pane.

i Y
J-' Panel Manager ﬂ

File Edit Bins View Help

WX | M M| W™ |snser Ve Pusans. + || (i T B B H (@@EE)

[ o5, Panel Manager Panel Hame Conunert

| AmpFLSTR_Panels_v3X 1 EFiIer_PIus_PaneI_vl Inone

& vfiler_Plus_v1

[ OK H Cancel H Apply H Help ]

b. Select File » Import Bin Set to open the Import Bin Set dialog box.
c. Navigate to, then open the Yfiler_Plus_Panels_v1 folder.
d. Select Yfiler_Plus_Bins_v1.txt, then click Import.

Note: Importing this file associates the bin set with the panels in the
Yfiler_Plus_Panels_v1 folder.

-

-
J.' Import Bin Set M

Look in: .J.YﬁlerPIusAnaI... = ? “E'

T & Vfiler_Plus_Bins_vl.bxt
&j || Yfiler_Plus_Panels_v1.tt
Recent Items | Yfiler_Plus_Stutter_vl.bt

Desktop File name: filer_Plus_Bins_v1.
i Files of type: :;\u Files -
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7. To view the imported panels in the navigation pane, double-click the
Yfiler_Plus_Panels_v1 folder to display the panel information in the right pane.

s® Panel Manager S
File Edit Bins View Help
> | B M| | Bnset:vfler Plus Bins vi ML EEE DEEBEEEN | @
=) ¢BuPanel Manager Barker Hame Tye Color | hfin Sise | hax Sise | Conirol Alleles Mfarkeer | Conments ¥ Mker | Ladder Allsles
[ AmpFLSTR Panels_v3x | [1 [pVesre Bus 680 1380 |19 4 none @] 10,11,12,13,14,15, 16,17, 18, 19,20,21,22,23,24,25
= ¥filer_Plus_v1 2 |D¥S3Eer Blue 1420 [184.0 |13 4 none @ 9,10,11,12,13,14,15,16, 17
= 3 |Dveeas Bue  |187.0 2570 |24 4 none [&] 15,16,17,18,19,20,21,22, 23,24, 25,26,27,28,29,30
Dys 3301 4 |D¥s3Ean Bus  |280.2 |34z |29 4 none @] 24,25,26,27,28,29,30,31,32,33,34,35
- DY5635 5 |Dvaee? Bue 3195 (3935 |21 4 none @] 11,12,13,14,15,16,17, 18,19, 20,21,22,23,24,25,26,27
DYS38911 5 |DVa4a0 Green |75.1  |113.0 |11 4 nane 0 |resaoinizasie
g:gg;; 7 |Dvs4sa Green 1150 |177.0 |17 4 none @] 11,12,13,14,15,16,17,18,19,20,21,22,23,24
. DY5458 3 |DVSio Green 1795 2295 |15 4 none ] 9,10,11,12,13,14,15,16,17,15,19
DY519 5 |GATA_H4+ Gresn |23l4 2694 |13 4 none @ 5,9,10,11,12,13,14,15
gs;:;:" 10 |DY5445 Green |27lz (B2 |19 3 none & 14,15,16,17,18,19,20,21,22,23,24
Dyassy 11 |ovs3at Green |348.5 4025 |11 4 none @] 5,6,7,8,9,10,11,12,13, 14,15,16
DYs456 12 |DV5456 Velow 7.0 |135.0 |15 4 none @] 10,11,12,13,14,15, 16,17, 18, 19,20,21,22,23,24
DYS390 13 |ovs390 velow |139.2  |197.2 |24 4 none [&] 17,18,19,20,21,22,23,24,25, 26,27,25,29
'g:g:gz 14 |DV5438 velow (2015 |2635 |12 5 none & 6,7,8,9,10,11,12,13,14,15, 16
Dyssia 15 |D¥5a92 Velow |270.0 3268 |13 3 none @] 4,5,6,7,8,9,10,11,12,13, 14,15, 16,17,16,19,20
DYs570 16 |D¥SE18 velow |327.8 (4060 |37 1 none @] 32,33,34,35,36,37,36,39,40,41,42,43,44,95,46,47,48,49
DY5437 17 |pvas70 Red 935 1675 |17 4 none @] 10,11,12,13,14,15,18,17,18, 19,20,21,22,23,24,25,26
DY5385 18 |DY5437 Red 1733 [215.3 |15 4 none & 10,11,12,1%,14,15,16,17,18
g:g;:g 19 [D¥5365 Red (22004 |3l8.4  |"11,14" 4 none @ 6,7,8,9,10,11,12,13,14,15,16, 17, 18,19,20,21,22,23,24,25,26,27,28
DYs439 20 |DvS449 Red  |320.8 4030 |30 4 none [&] 22,23,24,25,26,27,28,29,30,31,32,33,34, 35, 36,37,38,39,40
DY5481 21 |D¥5393 Purple  |85.36 13936 |13 4 none @] 7,8,9,10,11,12,13,14,15,16,17,18
& DYF38751 22 [D¥5439 Purple 1456 |199.6 |12 4 none [&] 5,7,8,9,10,11,12,13,14,15,16, 17
pYssz3 23 |DYs481 Purple  |203.0 2560 |2z 3 none [&] 17,18,19,20,21,22,23,24, 25, 26,27,28,29,30,31,32
24 |DYF38751  |Purple  |259.4  [325.0  |"35,37" 4 none @] 30,31,32,33,34,35,36,37, 38,39, 40,41,42,43,44
25 |D¥S533 Purple  |333.9 3839 |13 4 none @] 7,8,9,10,11,12,13,14,15,16,17
I, Reference Samples
[ OK ] [ Cancel I [ Apply ] [ Help ]

8. Import Yfiler_Plus_Stutter_v1:
a. Select the Yfiler_Plus_Panels_v1 folder in the navigation panel.

b. Select File » Import Marker Stutter to open the Import Marker Stutter dialog
box.

c. Navigate to, then open the Yfiler Plus Analysis files_v1X folder.
d. Select Yfiler_Plus_Stutter_v1, then click Import.

Note: Importing this file associates the marker stutter ratio with the bin set
in the Yfiler_Plus_Panels_v1 folder and overwrites any existing stutter ratios
associated with the panels and bins in that folder.

-~ Y
J_' Import Marker Stutter g

Lookin: | | Yfiler Plus Analysis files_v 1% = il | =]
ez | Yfiler_Plus_Bins_v1.txt
&j || Yfiler_Plus_Panels_v1.tt

Recent Items

Desktop .
File name: ‘ffiler_Plus_Stutter_v1.txt
[ ;I Files of type: | all Files =
—
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9. View the imported marker stutters in the navigation pane:

a. Double-click the Yfiler_Plus_Panels_v1 folder to display its list of kits in the
right pane.

b. Double-click the Yfiler_Plus_Panels_v1 folder to display its list of markers
below it.

c. Double-click DYS576, then click Stutter Ratio & Distance to display the
Stutter Ratio & Distance view for the marker in the right pane.

r Y
JL' Panel Manager ﬁ

File Edit Bins View Help
£ | B & @ | |@| |Bin5et: .Yﬁler_PIus_Bins_vl '_| [l % & % & | R R R ERER B | (71
- E.Yg\lresrs':éus")aneLu Please enter the stutter filter{s) for DYS576 marker here If left blank, the global stutter filter will be applied.

[ Stutter Ratio & Distance

1 DYS3831 Minus Stutter Plus Stutter

i DY5635

¢l DYS 38911 Ratio From Distance Tao Distance Ratio From Distance To Distance

i DYS5627 1515 3.25 475 0341 3.25 4.75

H- DYS460

H- DYS458

H- DYS519

H- GATA_H4

i DY5448

i DY5391 [ 4

th- DY5456

i DY53590

i DY5438

i DY5392

i DY5518

L. DIYEETN

m

) T BT e
) T BT e

[ mew |[ Edt |[ Delete |

00 o O e O O O o O o O o O e O O o O e WO O B

[ OK H Cancel H Apply H Help ]

10. Click Apply, then OK to add the Yfiler® Plus Kit panel, bin set, and marker
stutter to the GeneMapper® ID-X Software database.

IMPORTANT! If you close the Panel Manager without clicking Apply, the panels,
bin sets, and marker stutter will not be imported into the GeneMapper® ID-X
Software database.
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Create an analysis Use the following procedure to create an analysis method for the Yfiler® Plus Kit.
method

IMPORTANT! Analysis methods are version-specific, so you must create an analysis
method for each version of the software. For example, an analysis method created for
GeneMapper® ID-X version 1.2 is not compatible with earlier versions of
GeneMapper® ID-X Software or with GeneMapper® ID Software version 3.2.1.

1. Select Tools » GeneMapper® ID-X Manager to open the
GeneMapper® ID-X Manager.

 GeneMapper® ID-X Manager (%]

Find Mame Conkaining:

Projects | Analysis Methods | Table Settings || Plaot Settings || Matrices | Size Standards | Report Settings

[ Mew... ][ Open... ][ Save As... ][ Import... ][ Export,..

2. Select the Analysis Methods tab, then click New to open the Analysis Method
Editor with the General tab selected.

The figures below show the settings for each tab of the Analysis Method Editor.
Configure the Analysis Method Editor tab settings as shown in the figures below,
unless the instructions state otherwise.

Note: The Analysis Method Editor closes when you save your settings. To
complete this step quickly, do not save the analysis method until you finish
entering settings in all of the tabs.

3. After you enter settings in all tabs, click Save.
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General tab =
. Analysiz Method Editor
settings ¥
General | Allele | Peak Detector | Peak Quality | 5Q & GQ Settings |
—analysis Method Description
Mame: ¥filer Plus Analysis Method
Security Group: 'GeneMapper ID-¥ Security Group - .
Description: -
=
Instrument:
Analysis Type: HID
[ Save As ] [ Save ] [ Cancel ] [ Help ]
L. A

In the Name field, either type the name as shown or enter a name of your choosing. In
the Security Group field, select the Security Group appropriate to your software
configuration from the dropdown list. The Description and Instrument fields are
optional.
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Allele tab settings ) : =
Analysis Method Editor
| General | Allele | peak Detector | Peak Quality | SQ & GQ Settings|
Bin Set: .?ﬁler_PIus_Bins_vl - |
Use marker-spedific stutter ratio and distance if available

Marker Repeat Type: Tri Tetra Penta Hexa

Global Cut-off Value 0.0 0.0 0.0 0.0

MinusA Ratio 0.0 0.0 0.0 0.0

MinusA Distance From 0.0 0.0 0.0 0.0
To 0.0 0.0 0.0 0.0

Global Minus Stutter Ratio 0.0 0.0 0.0 0.0

Global Minus Stutter Distance  From (0.0 3.25 0.0 0.0
To 0.0 4,75 0.0 0.0

Global Plus Stutter Ratio 0.0 0.0 0.0 0.0

Global Plus Stutter Distance From 0.0 0.0 0.0 0.0
Te (0.0 0.0 0.0 0.0

Amelogenin Cutoff 0.0
Range Filter... Factory Defaults
[ Save As ] [ Save ] [ Cancel ] [ Help ]
L A

The settings shown in the screen shot above were used during the developmental
validation of the Yfiler® Plus Kit. To specify settings:

¢ In the Bin Set field, select the Yfiler_Plus_Bins_v1 bin set.

* GeneMapper® ID-X Software v1.0.1 or higher allows you to specify 4 types of
marker repeat motifs: tri, tetra, penta, and hexa. You can enter parameter values
for each type of repeat in the appropriate column.

* Specify the appropriate filter settings. To apply the stutter ratios contained in the
Yfiler_Plus_Stutter_v1 file, select the “Use marker-specific stutter ratio if
available” check box (selected by default).

Perform appropriate internal validation studies to determine the appropriate
filter setting to use.

Peak Detector tab IMPORTANT! The Local Southern Sizing algorithm has been validated for analysis of
settings Yfiler® Plus Kit data on 3130- and 3500-series instruments.
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Analysis Method Editor =
General | Allele | Peak Detector | peak Quality | SQ & GQ Settings |
Peak Detection Algorithm: Advanced
Ranges Peak Detection
Analysis . Sizing ] Peak Amplitude Thresholds:
Full Range v | |AlSizes - | B: R
Start Pt:|0 Start Size:|0 ’ '
Stop Pt: | 10000 Stop Size: | 1000 = =
Y: O
~Smoothing and Baselining
Min. Peak Half Width: 2 pts
Smoothing ™) None
- i - 3
@ Light Polynomial Degree
() Heavy Peak Window Size: 13 pts
Baseline Window: 33 pts Slope Threshold
Peak Start: 0.0
rSize Calling Method Peak End: 0.0
(7 2nd Order Least Squares
(7) 3rd Order Least Squares Normalization
! ) Cubic Spline Interpolation [C] Use Mormalization, if applicable
@) Local Southern Method
() Global Southern Method
’ Factory Defaults
Save As ] [ Save ] [ Cancel ] [ Help ]

IMPORTANT! Perform the appropriate internal validation studies to determine the
appropriate peak amplitude thresholds for interpretation of Yfiler® Plus Kit data.

Fields include:

¢ Peak amplitude thresholds — The software uses these parameters to specify the
minimum peak height, in order to limit the number of detected peaks. Although
GeneMapper® ID-X Software displays peaks that fall below the specified
amplitude in electropherograms, the software does not label or determine the
genotype of these peaks.

* Size calling method - The Yfiler® Plus Kit has been validated using the Local
Southern sizing method (60-460 base pairs). Select alternative sizing methods
only after performing the appropriate internal validation studies.

* Normalization — A Normalization checkbox is available on this tab in
GeneMapper® ID-X Software for use in conjunction with data run on the 3500
Series Genetic Analyzers.
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Peak Quality tab

Settings Analysis Method Editor =

| General | Allele | Peak Detector | Peak Quality | sQ & 6Q Settings|
/" Min/Max Peak Height (LPH/MPH)

Homozygous min peak height Perform
internal

Heterozygous min peak height X .

=/ P . validation

Max Peak Height (MPH) studies to
determine

Peak Height Ratio (PHR) settings

Min peak height ratio

\ p g
Broad Peak (ED)
Max peak width (basepairs) 1.5

Allele Number (AM)

Max expected alleles:
For autosomal markers & AMEL 2
For ¥ markers 1
Allelic Ladder Spike
Spike Detection [Enable |
Cut-off Value 0.2

Sample Spike Detection
Spike Detection Enable . |

[ Factory Defaults

Save As ][ Save ][ Cancel ][ Help ]

IMPORTANT! Perform the appropriate internal validation studies to determine the
heterozygous and homozygous minimum peak height thresholds, maximum peak
height threshold and the minimum peak height ratio threshold for interpretation of
Yfiler® Plus Kit data.
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Set up GeneMapper® ID-X Software for data analysis

SQ & GQ tab

. Analysis Methad Editor
settings

Quality weights are between 0 and 1.

| General I Allele I Peak Detector I Peak Quality | 50 & GQ Settings

Sample and Control GQ Weighting

Broad Peak (BD) 0.8
QOut of Bin Allele (BIN) 0.8
Owverlap (OVL) 0.8
Marker Spike [SPK) 0.3

AMEL Cross Chedk (ACC) 0.0

Control Concordance (CC) Weight = 1.0 (Only applicable to controls)

Allele Mumber (AM) 1.0
Low Peak Height (LFH) 0.3
Max Peak Height (MPH) 0.3
Off-scale (05) 0.8

Peak Height Ratio (PHR) 0.3

50 Weighting
Broad Peak (BD) 0.5

rAllelic Ladder GQ Weighting

Spike (SSPK/SPK) 1w Offscale (05) 1w
50 & GQ Ranges
Sizing Quality: From |0.75 to 1.0 From0.0te |0.25
Genotype Quality: From 0,75 to 1.0 From0.0te |0.25
Reset Defaults
Save As ] [ Save ] [ Cancel ] [ Help ]

IMPORTANT! The values shown are the software defaults and are the values we used
during developmental validation. Perform appropriate internal validation studies to
determine the appropriate values to use.

Create a size

standard
following peaks:

The GS600_LIZ_(60-460) size standard definition provided with GeneMapper® ID-X
Software v1.4 and used with the Local Southern size-calling method contains the

GeneScan™ 600 LIZ® Size Standard v2.0

60, 80, 100, 114, 120, 140, 160, 180, 200, 214, 220, 240, 250, 260, 280, 300, 314, 320, 340, 360,

380, 400, 414, 420, 440, and 460

Note: This size standard definition has been validated for use with the Yfiler® Plus Kit
on the Applied Biosystems® 3130/3130x/ and 3500/3500xL. instruments.
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Set up GeneMapper® ID-X Software for data analysis

If you need to create your own size standard definition, use the following procedure to
create the size standard definition file:

1.

Select Tools » GeneMapper® ID-X Manager to open the GeneMapper® ID-X
Manager.

Select the Size Standards tab, then click New.

« GeneMapper® ID-X Manager ®

Find Mame Containing: ‘| ‘

Projects | Analysis Methods | Table Settings | Plok Settings | Matrices | Size Standards | Report Settings

Marne Last Saved Cwner Type Description

CE_F_HID_G3500 (75-400) 2007-08-09 13:23:5 | gmid:x Advanced s
CE_F_HID_G3500 (75-450) 2007-08-09 13:24:0 | gmid: Advanced 1
CE_G5_HID_G3500 2011-04-18 13:15:¢ | gmids Advanced =

Complete the Name field as shown below or with a name of your choosing. In the
Security Group field, select the Security Group appropriate to your software
configuration from the drop-down list. In the Size Standard Dye field, select
Orange. In the Size Standard Table, enter the sizes specified on page 57.

#* Size Standand Editor, rs_<|
Edit

Size Standard Description

Mame:

Security Group:

Description:

Size Standard Dye: |Orange w |

rSize Standard Table

1_ Siozzin Basepairs

2z |s0.0

| >

3 |100.0

4 |114.0

5 |1z0.0

6 |140.0

7 |160.0

g |180.0

9 |z200.0

10 |214.0

11 |220.0

12 |240.0

13 |250.0

14 |260.0

15 |280.0

16 (300.0

17 |314.0
b

[ OF H Cancel H Help ]
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Analyze and edit sample files with GeneMapper® ID-X Software

Analyze and edit sample files with GeneMapper® ID-X Software

1. In the Project window, select Edit » Add Samples to Project, then navigate to the
disk or directory containing the sample files.

2. Apply analysis settings to the samples in the project.

Parameter Settings
Sample Type Select the sample type.
Analysis Method Yfiler_Plus_AnalysisMethod_v1 (or the name of the analysis
method you created)
Panel Yfiler_Plus_Panels_v1 (or the version installed)
Size Standard Use a size range of 60-460 bp for Local Southern size-calling
method.T

t The Yfiler® Plus Kit was originally validated using the GeneScan™ 600 LIZ® Size Standard v2.0. If you
use a different size standard, perform the appropriate internal validation studies to support the use of
this size standard with the Yfiler® Plus Kit.

Note: For more information about how the Size Caller works, refer to the

GeneScan™ Analysis Software for the Windows® NT Operating System Overview of the
Analysis Parameters and Size Caller User Bulletin (Pub. no. 4335617).
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Examine and edit a project

3. Click ™ (Analyze), enter a name for the project (in the Save Project dialog box),
then click OK to start analysis.

¢ The status bar displays the progress of analysis as a completion bar
extending to the right with the percentage indicated.

* The table displays the row of the sample currently being analyzed in green
(or red if analysis failed for the sample).

* The Analysis Summary tab is displayed and the Genotypes tab becomes
available upon completion of the analysis.

Analysis summary window after analysis

File Edit Analysis View Tools Admin Help

COW | %F MEEW | MEBR| P @ | rebesets | 35000t asyss ey B L,8R| D e
[ Samples| Analysis Summary | Genotypes|

Analysis Summary Summary Generation Date: Jun 24, 2014 3:58:
Select run folder to display: Al -
Sample Status [_Towl ofsamples |
& Unanalyz=d o |
Analyzed 0 |
W Analysis Setting Changed 36 |

Click a link below to display a fitered Samples Table containing only the samples slected

Allelic Ladder Quality per run folder (based on $Q and CGQ only)

Run Folder J[__Total # of Analyzed Ladders I -
(Inj5 2014-04-13-03-44-42-917 | 1 1 | o | o |
(Inj6 2014-04-15-05-4+4-42-927 | 1 |
Control Quality per project (based on sample PQVs: SOS, SSPK, MIX, OMR, SQ, CGQ)
Control Type [ Total = of Semples Al thresholds met @ One o more thresholds not met
FPositive Control [ o o
Custom Control 0 [ 0
Negative Contral q [ [
Total 0 [ 0
‘Sample Quality per project (based on sample PQVs: SOS, SSPK, MIX, OR, 5Q, CGQ)
[ )| Total # of Samples Il Althresholdsmet || @) One or more thresholds notmet |
samples | 2] | 2 | L |

Analysis Completed.

Examine and edit a project

You can display electropherogram plots from the Samples and Genotypes tabs of the
Project window to examine the data. These procedures start with the Analysis
Summary tab of the Project window (assuming the analysis is complete).
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For more information

For more information

For more information, refer to:

»  GeneMapper® ID-X Software v1.4 New Features and Installation Procedures User
Bulletin (Pub. no. 4477684)

o GeneMapper® ID-X Software Version 1.0 Getting Started Guide (Pub. no. 4375574)
o GeneMapper® ID-X Software Version 1.0 Quick Reference Guide (Pub. no. 4375670)
o GeneMapper® ID-X Software Version 1.0 Reference Guide (Pub. no. 4375671)

o GeneMapper® ID-X Software Version 1.1(Mixture Analysis) Getting Started Guide
(Pub. no. 4396773)

o GeneMapper® ID-X Software Version 1.2 Reference Guide (Pub. no. 4426481)
o GeneMapper® ID-X Software Version 1.2 Quick Reference Guide (Pub. no. 4426482)
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This chapter provides results of the developmental validation experiments we
performed using the Yfiler® Plus PCR Amplification Kit.

Validation of a DNA typing procedure for human identification applications is an
evaluation of the procedure’s efficiency, reliability, and performance characteristics. By
challenging the procedure with samples commonly encountered in forensic and
parentage laboratories, the validation process uncovers attributes and limitations
which are critical for sound data interpretation in casework (Sparkes, Kimpton,
Watson et al., 1996; Sparkes, Kimpton, Gilbard et al., 1996; Wallin et al., 1998).

We performed experiments to evaluate the performance of the Yfiler® Plus Kit
according to the updated and revised guidelines from the Scientific Working Group on
DNA Analysis Methods (SWGDAM, December 2012). Based on these guidelines, we
conducted experiments that comply with guidelines 2.0 and 3.0 and its associated
subsections. This DNA methodology is not novel. (Moretti ef al., 2001; Frank et al.,
2001; Wallin et al., 2002; and Holt et al., 2000).

This chapter will discuss many of the experiments we performed and examples of the
results we obtained. We chose conditions that produced optimum PCR product yield
and that met reproducible performance standards when using a peak amplitude
threshold of 175 RFUs. It is our opinion that while these experiments are not
exhaustive, they are appropriate for a manufacturer of STR kits intended for forensic
and/or parentage testing use.
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Developmental validation

SWGDAM guideline
2.2.1

SWGDAM guideline

3.9.2

PCR components
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“Developmental validation is the acquisition of test data and determination of conditions and
limitations of a new or novel DNA methodology for use on forensic, database, known or
casework reference samples.” (SWGDAM, December 2012).

“The reaction conditions needed to provide the required degree of specificity and robustness
should be determined. These include, but are not limited to, thermal cycling parameters, the
concentration of primers, magnesium chloride, DNA polymerase, and other critical reagents.”
(SWGDAM, December 2012).

We examined the concentration of each component of the Yfiler® Plus Kit and
established that the concentration of each component was within the range where data
indicated that the amplification met the required performance criteria for specificity,
sensitivity, and reproducibility. For example, 1 ng of DNA Control 007 was amplified
in the presence of varying concentrations of magnesium chloride, and the results were
analyzed on an Applied Biosystems® 3500xL Genetic Analyzer (Figure 4) The
performance of the multiplex is most robust within +20% of the optimal magnesium
chloride concentration.

Figure 4 Amplification of a mixture of 1 ng of male 007 DNA and 1 pg of female 9947 DNA with
varying concentrations of MgCl,, analyzed on the 3500xL Genetic Analyzer. Y-axis scale is 0 to

13,000 RFU.
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Developmental validation

Figure 5 Electropherograms obtained from amplification of a blood sample on FTA® card
amplified with the Yfiler® Plus Kit in the presence of varying concentrations of magnesium

chloride and analyzed on an Applied Biosystems® 3500xL Genetic Analyzer (Y-axis scale 0 to
10,000 RFU]).
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Figure 6 Electropherograms obtained from amplification of a buccal sample on FTA® card
amplified with the Yfiler® Plus Kit in the presence of varying concentrations of magnesium

chloride and analyzed on an Applied Biosystems® 3500xL Genetic Analyzer (Y-axis scale 0 to
28,000 RFU).
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Thermal cycling parameters were established for amplification of the Yfiler® Plus Kit
in the Veriti® 96-Well Thermal Cycler. Thermal cycling times and temperatures of
GeneAmp PCR systems were verified. Annealing and denaturation temperature
windows were tested around each stipend to verify that a +1.0°C window produced a
specific PCR product with the desired specificity for male DNA.

1T N (| B T A Ll |

The effects of denaturation and annealing temperatures on the amplification of Yfiler®
Plus Kit loci were examined using the control DNA 007, male-female DNA mixtures,
blood-FTA®, and buccal-FTA® samples.
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The denaturation temperatures tested were 93, 94, and 95°C, all for 4-second hold
times on the Veriti® 96-Well Thermal Cycler. The annealing temperatures tested were
60.5, 61, 61.5, 62, and 62.5°C (Figures 7, 8, and 9), for 1-minute hold times in the Veriti®
96-Well Thermal Cycler. The PCR products were analyzed using the 3500xL Genetic
Analyzer.

No preferential amplification was observed in the denaturation temperature
experiments. Of the tested annealing temperatures, 61, 61.5, and 62°C produced robust
profiles with no significant cross reactivity to 1 pug of female DNA. At 62.5°C, the yield
of the majority of loci was significantly reduced. This should pose no problem with
routine thermal cycler calibration and when following the recommended amplification
protocol. Preferential amplification was not observed at the standard annealing
temperature of 61.5°C.

Figure 7 Amplification of a mixture of 1 ng of male 007 DNA and 1 pg of female 9947 DNA at
annealing temperatures of 60.5, 61, 61.5, 62, 62.5, and 63°C, analyzed on an Applied

Biosystems® 3500xL Genetic Analyzer (Y-axis scale is 0 to 8,000 RFU).
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Figure 8 Electropherograms obtained from amplification of a blood sample on an FTA® card at

annealing temperatures of 60.5, 61, 61.5, 62, and 62.5°C, analyzed on an Applied Biosystems®
3500xL Genetic Analyzer (Y-axis scale is 0 to 12,000 RFU).
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Figure 9 Electropherograms obtained from amplification of a buccal sample on an FTA® card

at annealing temperatures of 60.5, 61, 1.5, 62, and 62.5°C, analyzed on an Applied Biosystems®
3500xL Genetic Analyzer (Y-axis scale is 0 to 10,000 RFU).

: l : ’ : 60.5°C

N T T Y W Y Lt
. . . . 1o

Lot il Lid W T bodid Ll
61.5°C

S O Y VW N W O [V I ddd 1
62°C

O O I A W W Y O W A Ll 1
62.5°C

Lboa | || NN bobi [T

Accuracy, precision, and reproducibility

SWGDAM Guideline
3.5

Accuracy

“Precision and accuracy of the assay should be demonstrated: Precision characterizes the degree
of mutual agreement among a series of individual measurements, values and/or results.
Precision depends only on the distribution of random errors and does not relate to the true value
or specified value. The measure of precision is usually expressed in terms of imprecision and
computed as a standard deviation of the test results. Accuracy is the degree of conformity of a
measured quantity to its actual (true) value. Accuracy of a measuring instrument is the ability
of a measuring instrument to give responses close to a true value.” (SWGDAM, December
2012)

Laser-induced fluorescence detection of length polymorphism at short tandem repeat
loci is not a novel methodology (Holt et al., 2000; and Wallin et al., 2002). However,
accuracy and reproducibility of Yfiler® Plus Kit profiles have been determined from
various sample types. Figure 10 shows the size differences that are typically observed
between sample alleles and allelic ladder alleles on the Applied Biosystems® 3500xL
Genetic Analyzer with POP-4™ polymer. The X-axis represents the nominal nucleotide
sizes for the Yfiler® Plus Allelic Ladder. The dashed lines parallel to the X-axis
represent the +0.5-nt windows. The Y-axis represents the deviation of each sample
allele size from the corresponding Yfiler® Plus Allelic Ladder allele size. All sample
alleles are within 0.5 nt from a corresponding allele in the Yfiler® Plus Allelic Ladder.
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Precision and size
windows
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Figure 10 Size deviation of 78 samples analyzed on the 3500xL Genetic Analyzer

Precision (3500xI)

Marker
DYF38751
= DYS19
DYS385
DYS3891
DYS38911
DYS390
DYS391
DYS392
DYS393
DYS437
DYS438
DYS439
DYS448
DYS449
DYS456
DYS458
DYS460
DYS481
DYS518
DYS533
DYS570
DYS576
DYS627

T T T T T T T DY5635
100 150 200 250 300 350 400 | . yGATAH4

Allele Size (nt)

1.0

»>

0.5 o

X+ 4 A

) i
0.0-— |} e Th T 111 :

o
P
»
¥
k'S4
(25 5]
¢
*®

Size Deviation (nt)
Avproe

1

+

o m @ %

-1.0

Sizing precision allows for determination of accurate and reliable genotypes. Sizing
precision was measured on the 3130x/, 3500, and 3500xL Genetic Analyzers. The
recommended method for genotyping is to use a £0.5-nt “window” around the size
obtained for each allele in the Yfiler® Plus Allelic Ladder. A +0.5-nt window allows for
the detection and correct assignment of alleles. Any sample allele that sizes outside a
window could be either of the following;:

* An “off-ladder” allele, for example, an allele of a size that is not represented in the
Yfiler® Plus Allelic Ladder

* An allele that does correspond to an allelic ladder allele, but whose size is just
outside a window because of measurement error

The measurement error inherent in any sizing method can be defined by the degree of
precision in sizing an allele multiple times. Precision is measured by calculating the
standard deviation in the size values obtained for an allele that is run in several
injections on a capillary instrument. Table 8 on page 93 indicates typical precision
results obtained from the seven injections of the Yfiler® Plus Allelic Ladder analyzed
on the 3130x/, 3500, and 3500xL Genetic Analyzers (36-cm capillary and POP-4®
polymer). The size standard used was GeneScan™ 600 LIZ® Size Standard v2.0. The
results were obtained within a set of injections on a single capillary array.

As indicated above, sample alleles may occasionally size outside of the +0.5-nt window
for a respective allelic ladder allele because of measurement error. The frequency of
such an occurrence is lowest in detection systems having the smallest standard
deviations in sizing. Table 8 on page 93 illustrates the tight clustering of allele sizes
obtained on the 3500xL Genetic Analyzer, where the standard deviation in sizing is
typically less than 0.15 nt. The instance of a sample allele sizing outside of the +0.5-nt
window because of measurement error is relatively rare when the standard deviation
in sizing is approximately 0.15 nt or less (Smith, 1995).
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For sample alleles that do not size within a +0.5-nt window, the PCR product must be
rerun to distinguish between a true off-ladder allele vs. measurement error of a sample
allele that corresponds with an allele in the allelic ladder. Repeat analysis, when
necessary, provides an added level of confidence to the final allele assignment.
GeneMapper® ID-X Software automatically flags sample alleles that do not size within
the prescribed window around an allelic ladder allele.

It is important to note that while the precision within a set of capillary injections is very
good, the determined allele sizes vary between platforms. Cross-platform sizing
differences arise from a number of parameters, including type and concentration of
polymer mixture, run temperature, and electrophoresis conditions. Variations in sizing
can also be found between runs on the same instrument and between runs on different
instruments because of these parameters. We strongly recommend that the allele sizes
obtained be compared to the sizes obtained for known alleles in the Yfiler® Plus Allelic
Ladder from the same run and then converted to genotypes. For more information on
precision and genotyping, see Lazaruk ef al., 1998 and Mansfield et al.,1998.

Extra Peaks in the electropherogram

Causes of extra
peaks

Stutter products

Peaks other than the target alleles may be detected on the electropherogram displays.
Several causes for the appearance of extra peaks, including the stutter product (at the
n—4 position), incomplete 3" A nucleotide addition (at the n—1 position), artifacts, and
mixed DNA samples (see “SWGDAM Guideline 3.8” on page 87).

Stutter is a well-characterized PCR artifact that refers to the appearance of a minor
peak one repeat unit smaller (or less frequently, one repeat larger) than the major STR
product (Butler, 2005; Mulero ef al., 2006). Sequence analysis of stutter products at
tetranucleotide STR loci has revealed that the stutter product is missing a single
tetranucleotide core repeat unit relative to the main allele (Walsh et al., 1996).

Most STR loci produce minus-stutter peaks as a by-product of PCR amplification. A
process of “slippage” has been proposed as a molecular mechanism for stutter, where
the Tag DNA polymerase enzyme “slips” on the template DNA during replication and
produces a minority PCR product that is shorter than the template strand, usually by
one repeat unit. The stutter process may also occur in the opposite direction to produce
amplicon DNA that is usually one repeat unit longer than the template strand, termed
plus-stutter. While plus-stutter is normally much less significant (<5%) than minus-
stutter in STR loci with tetranucleotide repeats, the incidence of plus-stutter is more
significant in the trinucleotide repeat-containing loci DYS481 and DYS392 as shown in
Table 3 on page 71.

GeneMapper® ID-X analysis files supplied for use with theYfiler® Plus Kit contain
plus-stutter filters for several markers to prevent these peaks from being called in
normal profiles. To obtain a Technical Note regarding plus stutter in STR chemistries,
see your local Life Technologies HID support representative.
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A non-standard (minus 2-nt) stutter has been observed in certain Y-STR loci that
include more complex nucleotide sequences including regions of dinucleotide repeats
as shown in Figure 18 on page 77. In cases where these stutter peaks exceed the peak
amplitude threshold (e.g., 175 RFU), they may be detected by analysis software as
additional alleles in the profile. GeneMapper® ID-X analysis files supplied for use with
the Yfiler® Plus Kit contain a minus 2-nt stutter filter for DYS19, DYS481, DYS533 and
DYS627 to prevent these peaks from being called in normal profiles.

The proportion of the stutter product relative to the main allele (stutter percent) is
measured by dividing the height of the stutter peak by the height of the main allele
peak. Such measurements have been made at Life Technologies for amplified samples
at the loci used in the Yfiler® Plus Kit. All data were generated on the 3500xL Genetic
Analyzer.

The stutter measurements were derived from DNA extracted from blood samples
acquired from the Interstate Blood Bank (Memphis, Tennessee) and Boca Biolistics
(Coconut Creek, Florida). The samples were collected in the United States (with no
geographical preference) from randomly-selected individuals of known ethnicities.

Some of the general conclusions from these measurements and observations are as
follows:

* For each Yfiler® Plus Kit locus, the stutter percent generally increases with allele
length, as shown in Figure 11 through Figure 17 on the following pages. Smaller
alleles display a lower level of stutter relative to the longer alleles within each
locus. Alleles at the low/high extreme end of the range have minimal data points
due to poor representation in the Life Technologies data set. Some of these alleles
were not represented at all.

* Each allele within a locus displays percent stutter that is reproducible.

e Stutter filter sets in GeneMapper® ID-X Software, calculated as the mean stutter
for the locus plus three standard deviations, are shown in Table 3. Peaks in the
stutter position that are above the stutter filter percentage specified inthe software
are not filtered. Peaks in the stutter position that have not been filtered and
remain labeled can be further evaluated. For evaluation of mixed samples, see
“Mixture studies” on page 87.

* The measurement of percent stutter for alleles that are off-scale may be unusually
high due to artificial truncation of the main allele peak.
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Table 3 Marker-specific stutter filter percentages for Yfiler® Plus Kit loci

desl-i;(r:\l;:ion % Minus stutter? % Plus stuttert "/oMinusS-tZUt/t"/;I;lus-Z nt
DYS576 15.15 3.38 E:
DYS3891 9.16 3.45 :
DYS635 13.38 33 E:
DYS38911 18.79 | 3.73 E:
DYS627 15.18 2.62 2.71
DYS440 11.65 | 4.27 E:
DYS458 15.31 2.52 E:
DYS19 12.68 | 3.72 10.1/3.42
YGATAHA 1153 2.27 :
DYS448 4.68 | 2.29 E:
DYS391 9.99 3.41 E:
DYS456 15.36 | 3.74 E:
DYS390 13.58 3.51 :
DYS438 5.86 | 2.76 E:
DYS392 16.94 11 E:
DYS518 25.5 | 4.85 E:
DYS570 15.65 2.88 :
DYS437 8.13 | 1.65 E:
DYS385 18.32 3.7 E:
DYS449 23.24 | 4.2 E:
DYS393 14.07 4.95 :
DYS439 9.89 | 3.39 E:
DYS481 28.55 5.59 9.55
DYF38751 15.71 | NA E:
DYS533 12 4.6 1.88

T The stutter filters are displayed as percentages in the GeneMapper ID-X Yfiler_Plus_Stutter.txt file.
I Undetermined

IMPORTANT! The values in Table 3 were determined by Life Technologies during the
developmental validation studies. We recommend that laboratories perform their own
internal validation studies to determine the appropriate values to use.
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Figure 11 Minus stutter percentages for the DYF38751, DYS19, and DYS385 loci. (Blue, green,
black, red, and purple colors indicate loci labeled with 6-FAM™, VIC™, NED™, TAZ™, and SID™
dyes, respectively.)
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Figure 12 Minus stutter percentages for the DYS3891, DYS3891l, DYS390, and DYS391 loci. (Blue,
green, black, red, and purple colors indicate loci labeled with 6-FAM™, VIC™, NED™, TAZ™, and
SID™ dyes, respectively.)
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Figure 13 Minus stutter percentages for the DYS392, DYS393, DYS437, and DYS438 loci. (Blue,
green, black, red, and purple colors indicate loci labeled with 6-FAM™, VIC™, NED™, TAZ™, and
SID™ dyes, respectively.)
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Figure 14 Minus stutter percentages for the DYS439, DYS448, DYS449, and DYS456 loci. (Blue,
green, black, red, and purple colors indicate loci labeled with 6-FAM™, VIC™, NED™, TAZ™, and
SID™ dyes, respectively.)
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Figure 15 Minus stutter percentages for the DYS458, DYS460, DYS481, and DYS518 loci. (Blue,
green, black, red, and purple colors indicate loci labeled with 4-FAM™, VIC™, NED™, TAZ™, and
SID™ dyes, respectively.)
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Figure 16 Minus stutter percentages for the DYS533, DYS570, and DYS576 loci. (Blue, green,

black, red, and purple colors indicate loci labeled with 6-FAM™, VIC™, NED™, TAZ™, and SID™
dyes, respectively.)
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Figure 17 Minus stutter percentages for the DYS627, DYS635, and YGATAH4 loci. (Blue, green,

black, red, and purple colors indicate loci labeled with 6-FAM™, VIC™, NED™, TAZ™, and SID™
dyes, respectively.)
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Figure 18 Example of reproducible 2-nt stutters in the DYS19 (left) and DYS481 (right) loci.
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Many DNA polymerases can catalyze the addition of a single nucleotide
(predominately adenosine) to the 3" ends of double-stranded PCR products (Clark,
1988; Magnuson et al.,1996). This non-template addition results in a PCR product that
is one base pair longer than the actual target sequence, and the PCR product with the
extra nucleotide is referred to as the “+A” form (Figure 19).

The efficiency of “A addition” is related to the particular sequence of the DNA at the 3’
end of the PCR product. The Yfiler® Plus Kit includes two main design features that
promote maximum A addition:

* The primer sequences have been optimized to encourage A addition.

¢ The final extension step is 60°C for 22 minutes.

This final extension step gives the DNA polymerase additional time to complete +A
addition to all double-stranded PCR products. See Figure 19 for an example of
incomplete and normal +A addition. Final extension incubation for longer than the
recommended 22 minutes may result in double +A addition, in which two non-
template adenosine residues are added to the PCR product. Double +A addition can
cause “shoulders” on the right side of main allele peaks, and is therefore to be avoided.

Figure 19 Time course of 7, 12, 17 and 22 minutes during the final extension step. A mixture
of 1 ng of male DNA and 1 ug of female DNA was amplified with increasing final extension times
resulting in complete +A addition at the DYS438 locus and the disappearance of the OL (-A)
shoulder peak.
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Lack of full A nucleotide addition may be observed in Yfiler® Plus Kit results when the
amount of input DNA is greater than recommended protocols. This is because more
time is needed for the DNA Polymerase to add the A nucleotide to all molecules as
more PCR product is generated. Amplification of too much input DNA will also result
in off-scale data.
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Extra Peaks in the electropherogram

Artifacts and anomalies are seen in all molecular biological systems. Artifacts are
typically reproducible while anomalies are non-reproducible, intermittent occurrences
that are not observed consistently in a system (for example, spikes and baseline noise).
Due to improvements in PCR primer manufacturing processes, the incidence of
artifacts has been greatly reduced in the Yfiler® Plus PCR Amplification Kit. Kit
electropherograms are essentially free of reproducible dye artifacts within the kit's
read region for commonly used analytical thresholds.

Additional reproducible DNA-dependent artifacts have been characterized and
documented on Table 4. It is important to consider possible noise and artifacts when
interpreting data from the Yfiler® Plus Kit on the Applied Biosystems® 3500/3500xL
and 3130/3130x! Genetic Analyzers.

Table 4 DNA-dependent artifacts

Artifact Color Size Comment
FAM270 Blue 270-271 | Minor cross-reactive product observed with female DNA
in excess of 2 ug.
FAM280 ' Blue 280-281 | Minor cross-reactive product observed with female DNA
in excess of 2 ug.
FAM348 Blue 348-349 | Specific to cell-line derived kit Control DNA.

Y391 (n-10]  Green  n-10nt Specific to DYS391. Minor cross-reactive product
observed with male DNA in excess of 1.0 ng.

TAZ140 Red 139-140 | Minor cross-reactive product observed with female DNA
in excess of 2 ug.
TAZ144 Red 144-145 | Minor cross-reactive product observed with female DNA

in excess of 2 ug.

TAZ225-260  Red 225-260 | Multiple minor cross-reactive products observed with
female DNA in excess of 2 ug.

TAZ412 Red 412-413 | Cross-reactive product observed with female DNA in
excess of 100 ng. Occurs outside of the read region. Does
not impact interpretation.

VIC70 Green |70 Sporadic PCR artifact. Occurs outside of the VIC read
region. Does not impact interpretation.
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Figure 20 Examples of reproducible artifacts in data produced on the Applied Biosystems 3500/

3500xL. The top panel is TAZ412, the middle panel is FAM348, and the bottom panel is
Y391 (n-10)
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Characterization of loci

SWGDAM Guideline  “The basic characteristics of a genetic marker must be determined and documented.”
3.1 (SWGDAM, December 2012).

This section describes basic characteristics of the 27 loci that are amplified with the
Yfiler® Plus Kit. These loci have been extensively characterized by other laboratories
(Gusmao et al., 1999; Butler et al., 2002; Gonzalez-Neira et al., 2001; Hall and Ballantyne,
2003; Redd et al., 2002; Schoske ef al., 2004; Ballantyne ef al., 2012; Ballantyne et al.,

2014).
Nature of the DYS392 and DYS481 are trinucleotide repeats, DYS438 is a pentanucleotide repeat and
polymorphisms DYS448 is a hexanucleotide repeat. Their allele differences result from differences in

the number of repeat units 3-bp, 5-bp and 6-bp respectively. The remaining Yfiler®
Plus Kit loci are tetranucleotide short tandem repeat (STR) loci. The length differences
among alleles of these particular loci result from differences in the number of 4-bp
repeat units.

We have sequenced all the alleles in the Yfiler® Plus Allelic Ladder. In addition, other
groups in the scientific community have sequenced alleles at some of these loci (Redd
et al., 2002; www.cstl.nist.gov/biotech/strbase/y_strs.htm ). Among the various
sources of sequence data on the Yfiler® Plus Kit loci, there is consensus on the repeat
patterns and structure of the STRs (Mulero et al., 2014; Gusmao ef al., 2006).

Inheritance The Centre d’Etude du Polymorphisme Humain (CEPH) has collected DNA from
39 families of Utah Mormon, French Venezuelan, and Amish descent. These DNA sets
have been extensively studied all over the world and are routinely used to characterize
the mode of inheritance of various DNA loci. Each family set contains three
generations, generally including four grandparents, two parents, and several
offspring. Consequently, the CEPH family DNA sets are ideal for studying inheritance
patterns (Begovich et al.,1992).

Three CEPH family DNA sets were examined. 1 ng of DNA from each sample was
amplified using the Yfiler® Plus Kit and the Identifiler® Kit, followed by analysis using
a 3500xL Genetic analyzer. The families examined included #1333 (9 offspring, 7
males), #1340 (7 offspring, 5 males), and #1345 (7 offspring, 5 males), representing 23
meiotic divisions. The Identifiler® Kit results confirmed that the loci are inherited
according to Mendelian rules, as reported in the literature (Nakahori et al.,1991;
Edwards et al.,1992; Kimpton et al.,1992; Mills et al.,1992; Sharma and Litt, 1992; Li et
al.,1993; Straub et al.,1993). The Yfiler® Plus Kit results confirmed that the loci were
inherited according to a Y-linked (father to son) transmission. In no case was the
maternal grandfather’s Y-haplotype found in the offspring. Calculation of a mutation
rate based on this small population size would be inaccurate due to the small sample
size. The samples were reamplified and reinjected to confirm the allele call.

Mapping The Yfiler® Plus Kit loci have been mapped and the chromosomal location on the
Y-chromosome is known based on the nucleotide sequence of the Y-chromosome. The
Genbank accession numbers for representative sequences are: DYS19 (X77751,
ACO017019), DYS385 (AC022486, 2Z93950), DYS389 (AC011289, AF140635), DYS390
(AC011289), DYS391 (G09613, AC011302), DYS392 (G09867, AC06152), DYS393
(G09601, AC06152), DYS437 (AC002992), DYS438 (AC002531), DYS439 (AC002992),
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DYS448 (AC025227.6), DYS456 (AC010106.2), DYS458 (AC010902.4), DYS635 (G42676,
AC011751), DYS635 (G42673), DYS449 (AC051663), DYS481 (FJ828747.1), DYS533
(AC053516), DYS570 (AC012068), DYS576 (AC010104), DYS518 (F]828760) and DYS627
(BV208976).

Species specificity

SWGDAM Guideline
3.2

82

“The ability to detect genetic information from non-targeted species (e.g., detection of microbial
DNA in a human assay) should be determined.” (SWGDAM, December 2012).

The Yfiler® Plus Kit provides the required degree of specificity such that it is specific to
primates. Other species do not amplify for the loci tested.
Nonhuman Studies

Nonhuman DNA may be present in forensic casework samples. The Yfiler® Plus Kit
provides the required degree of specificity for the species tested (Figure 21 on page 82).

Figure 21 Representative electropherograms from a species specificity study including positive
and negative control
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The following experiments were conducted to investigate interpretation of Yfiler® Plus
Kit results from nonhuman DNA sources.

The extracted DNA samples were amplified in Yfiler® Plus Kit reactions and analyzed
using the 3100 Genetic Analyzer.

* Primates — Gorilla, chimpanzee, and macaque (1.0 ng each).
* Non-primates — Mouse, dog, pig, rat, sheep, horse, chicken and cow (10 ng each).

* Microorganisms — Candida albicans, Neisseria gonorrhoeae, Escherichia coli 0157:H7,
Bacillus subtilis, Staphylococcus aureus, and Lactobacillus rhamnosus (5 ng each).

The chimpanzee and gorilla DNA samples produced partial profiles within the
100-330 base pair region.

The remaining species tested did not yield reproducible detectable products.
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SWGDAM Guideline
3.3

Effect of DNA
quantity on results
and importance of
quantitation

Chapter 5 Experiments and Results

Sensitivity

“The ability to obtain reliable results from a range of DNA quantities, to include the upper and
lower limits of the assay, should be evaluated.” (SWGDAM, December 2012).

In a casework workflow, the optimal amount of input male DNA added to the Yfiler®
Plus Kit should be between 0.5 and 1.0 ng for 30 cycles of amplification (Figure 22 on
page 84). The DNA sample should be quantitated prior to amplification using a system
such as the Quantifiler® HP (Human Plus) DNA Quantification Kit (Part no. 4482911)
or the Quantifiler® Trio DNA Quantification Kit (Part no. 4482910). The final DNA
concentration should be in the range of 0.05-0.10 ng/uL so that 0.5-1.0 ng of male DNA
will be added to the PCR reaction in a volume of 10 pL. If the sample contains
degraded DNA, amplification of additional DNA may be beneficial.

If too much male DNA is added to the PCR reaction, then the increased amount of PCR
product that is generated can result in the following:

¢ Fluorescence intensity that exceeds the linear dynamic range for detection by the
instrument (“off-scale” data).

Off-scale data is a problem for two reasons:

— Quantitation (peak height and area) for off-scale peaks is not accurate. For
example, an allele peak that is off-scale can cause the corresponding stutter
peak to appear higher in relative intensity, thus increasing the calculated
percent stutter.

— Multicomponent analysis of off-scale data is not accurate, which results in
poor spectral separation (“pull-up”).

¢ Incomplete A nucleotide addition.
The sample can be re-amplified using less DNA.

Individual laboratories may find it useful to determine an appropriate minimum peak
height threshold based on their own results and instruments using low amounts of
input DNA. This kit was developed using two injection conditions (3130x/; 3 kV/10 sec
and 3 kV/13 sec, 3500; 1.2 kV/16 sec and 1.5 kV/16 sec, 3500xL; 1.2 kV/24 sec and 1.5 kV/
24 sec). You are encouraged to explore both options during validation to determine
which protocol provides the best results on your instrumentation. The enhanced
injection conditions resulted on average improvements in peak height of 25%

(Figure 22 on page 84).

Note: Please refer to Section 2.2 on page 25 to optimize the PCR cycle number used for
direct amplification from multiple sample types and substrate combinations.
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SWGDAM Guideline
3.4

Lack of
amplification of
some loci

Effect of inhibitors

84

Figure 22 Effect of amplifying 1 ng, 500 pg, 250 pg, 125 pg, 62 pg, and 31 pg of male control
DNA 007 using two voltage conditions. Data analyzed using the 3500xL Genetic Analyzer. The Y-
axis scale is 0 to 12,000 RFUs.
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“The ability to obtain results from DNA recovered from biological samples deposited on various
substrates and subjected to various environmental and chemical insults should be evaluated. In
most instances, assessment of the effects of these factors on new forensic DNA procedures is not
required. However, if substrates and/or environmental and/or chemical insults could potentially
affect the analytical process, then the process should be evaluated to determine the effects of such
factors.” (SWGDAM, December 2012)

As with any multi-locus system, the possibility exists that not every locus will amplify.
This is most often observed when the DNA sample contains PCR inhibitors or when
the DNA sample has been severely degraded. Valuable information may be obtained
from partial profiles.

Traces of humic acid may inhibit the PCR amplification of DNA evidence collected
from soil. Amplification of 1.0 ng of DNA Control 007 in the presence of increasing
amounts of humic acid was performed using the Yfiler® Plus Kit (Figure 23 on
page 85). The concentrations of humic acid tested were 0, 100, and 250 ng/uL. The
same concentrations were tested with the Yfiler® Kit for comparison. At 250 ng/uL,
neither kit yielded amplified products.
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Figure 23 Electropherograms for the Yfiler® Plus and AmpF(STR® Yfiler Kits show the
improved performance of the Yfiler® Plus Kit in the presence of humic acid compared to the

Yfiler® Kit. The Y-axis scale is 0 to 20,000 RFUs for the top two panels, 0 to 30,000 RFUs for
the third panel, and 0 to 4000 RFUs for the bottom panel.
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As the average size of degraded DNA approaches the size of the target sequence, the
amount of PCR product generated is reduced. This is due to the reduced number of
intact templates in the size range necessary for amplification.

Degraded DNA was prepared to examine the potential for preferential amplification of
loci. High molecular weight DNA was incubated with the enzyme DNase I for varying
amounts of time. The DNA was examined by agarose gel analysis to determine the
average size of the DNA fragments at each time point.

2 ng of degraded DNA (or 1 ng undegraded DNA) was amplified using the Yfiler®
Plus Kit. As the DNA became increasingly degraded, the loci became undetectable
according to size. The loci failed to robustly amplify in the order of decreasing size as
the extent of degradation progressed (Figure 24).
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Figure 24 Amplification of A3121 DNA samples sonicated and incubated with increasing doses
of DNase I. Panels 1, 2, 3, and 4 correspond to 0, 4, 5, and 6 units of DNase |. Note that the Y-
axis scale is magnified for more degraded samples, which generate lower peak heights.
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Mixture studies

SWGDAM Guideline

3.8

Male/female

mixture studies

“The ability to obtain reliable results from mixed source samples should be determined.”
(SWGDAM, December 2012).

Evidence samples may contain DNA from more than one individual. The possibility of
multiple contributors should be considered when interpreting the results. We
recommend that individual laboratories assign a minimum peak height threshold
based on validation experiments performed in each laboratory to avoid typing when
stochastic effects are likely to interfere with accurate interpretation of mixtures.

Evidence samples that contain body fluids and/or tissues originating from more than
one individual are an integral component of forensic casework. Therefore it is essential
to ensure that the DNA typing system is able to detect DNA mixtures. In the case of
Y-STRs, the female DNA component is not amplified by the Y-chromosome specific
primers. Male/female mixture studies were performed up to a ratio of 1:4000 using
three different female DNAs. The amount of female DNA was kept constant at 1 pg
and the amount of male control DNA was changed. The female DNA did not cause
any interference with the interpretation of the male Y-STR profile as shown in

Figure 25.

Low level artifacts with female DNA have been occasionally observed in the FAM™

(270-280 bp) and TAZ™ (225-260 bp) dye. In general, these artifacts peaks should not
affect interpretation due to their morphology and intensity.

Figure 25 Amplification of male Control DNA 007 in the presence of female DNA 9947A. Profiles
shown in the panels from top to bottom: 1 ng of male DNA, 1 ng male DNA with 1 pg female
DNA, 500 pg male DNA with 1 pg female DNA, 250 pg male DNA with 1 pg female DNA, 1 g
female DNA. Note that the Y-axis scale is magnified for lower input amounts of male DNA
samples, which generate lower peak heights (Y-axis scale is 0 to 200 RFUs for the 1 ug female
input).
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Male/male mixture  Forensic samples may contain body fluids or tissues originating from more than one
studies male.

Mixtures of two male DNA samples were examined at various ratios (1:1 to 1:15). The
total amount of genomic input DNA mixed at each ratio was 1 ng.

Table 5 Haplotypes of samples in Figure 26

Allele Sample A Sample B
DYS576 15 19
DYS3891 14 13
DYS635 21 ' 24
DYS38911 31 29
DYS627 21 21
DYS460 10 1
DYS458 17 ' 17
DYS19 15 15
YGATAHA 12 13
DYS448 21 19
DYS391 10 ' 1
DYS456 13 15
DYS390 21 24
DYS438 12 12
DYS392 11 ' 13
DYS518 38 37
DYS570 19 17
DYS437 14 15
DYS385 16,19 ' 11, 14
DYS449 29 30
DYS393 14 13
DYS439 11 12
DYS481 27 ' 22
DYF38751 36, 39 35, 37
DYS533 11 13

A representative electropherogram of 1-ng total male/male DNA mixture studies is
shown in Figure 26. The limit of detection is when the minor component is present at
approximately one-tenth of the concentration of the major component. The limit of
detection for the minor component is influenced by the combination of genotypes in
the mixture.
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Figure 26 Mixtures of two male DNA samples (1:8 ratio, 125 pg:875 pg) 1-ng input DNA. The
alleles attributable to the minor component, even when the major component shares an allele,
are highlighted.
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“The laboratory should establish guidelines for the number of Y-STR loci used for searches of
population databases.” (SWGDAM, January 2014)

All Y-STR loci analyzed in commercial kits are physically linked on the Y-chromosome.
Due to the lack of recombination, the entire Y-chromosome haplotype must be treated
as a single locus. Haplotype frequencies are estimated using the counting method. The
counting method involves searching a given haplotype against a database to
determine the number of times the haplotype was observed in that database. The
frequency of the haplotype in the database is then estimated by dividing the count by
the number of haplotypes searched. (SWGDAM, January 2014)

The Yfiler® Plus Kit was used to generate the population data provided in this section.
Samples were collected from individuals throughout the United States with no
geographical preference.

Population Number of samples
African-American 557
U.S. Caucasian 533
U.S. Hispanic 391
U.S. Asian 340

Table 6 shows the Yfiler® Plus Kit gene diversity in three populations, listed as

percentages.
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Population data

Table 6 Yfiler® Plus Kit Gene Diversity values across four different U.S. populations

Locus AAn:r;;ls?cr;-n Caul::.ass.ian U.S. Hispanic U.S. Asian
(n = 557) (n = 533) [n =391) (n=340]
DYS576 0.807 0.768 0.769 0.799
DYS389I 0.504 0.527 0.567 0.679
DYS635 ' 0.716 | 0.646 ' 0.713 0.786
DYS389l 0.746 0.676 0.729 0.770
DYS627 ” 0.838 | 0.842 ” 0.853 0.812
DYS460 0.573 0.537 0.571 0.675
DYS458 ' 0.750 | 0.766 ' 0.800 0.820
DYS19 0.726 0.459 0.632 0.703
YGATAHA ” 0.590 | 0.585 ” 0.580 0.606
DYS448 0.707 0.583 0.697 0.755
DYS391 ' 0.445 | 0.540 ' 0.561 0.437
DYS456 0.615 0.737 0.700 0.603
DYS390 ‘ 0.646 | 0.484 ‘ 0.656 0.699
DYS438 0.551 0.581 0.488 0.547
DYS392 ' 0.445 | 0.592 ' 0.664 0.710
DYS518 0.843 0.806 0.807 0.867
DYS570 ‘ 0.806 | 0.738 ‘ 0.799 0.820
DYS437 0.504 0.577 0.592 0.476
DYS385 ' 0.942 | 0.854 ' 0.904 0.973
DYS449 0.857 0.783 0.818 0.882
DYS393 ‘ 0.587 | 0.363 ‘ 0.442 0.662
DYS439 0.629 0.625 0.682 0.669
DYS481 ' 0.857 | 0.724 ' 0.790 0.821
DYF38751 0.941 0.874 0.913 0.945
DYS533 ‘ 0.598 | 0.576 ‘ 0.591 0.644
n(l - Ep;2

Gene diversity (D) =

| where n = sample size, p; = allele frequency
(Johnson et al., 2003). ™~

Anal_yzing the In addition to the alleles that were observed and recorded in the Life Technologies

population data databases, other known alleles have been published or reported to us by other
laboratories. Some of these alleles occur at a low frequency and include several
microvariants (Furedi et al., 1999; Schoske et al., 2004).
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Chapter 5 Experiments and Results

Mutation rate

Discriminatory capacity of haplotypes

Table 7 shows the discriminatory capacity (DC) and the number of unique haplotypes
(UH) for each Y-STR marker combination listed. The discriminatory capacity was
determined by dividing the number of different haplotypes by the number of samples
in that population (Schoske ef al., 2004). A unique haplotype is defined as one that
occurs only once in a given population. The number of unique haplotypes is usually
less than the number of different haplotypes in any given population.

Table 7 Discriminatory capacity and number of unique haplotypes for four U. S. populations

African-American U.S. Caucasian U.S. Hispanics U.S. Asian
Y-STR marker (N=557) (N=533) (N=391) (N=340)
combination
DC (%) UH DC (%) UH DC (%) UH DC (%) UH
Yfiler® 98.2 547 95.7 510 95.9 375 91.5 3N
Yfiler® Plus 99.6 555 98.5 525 98.0 383 94.4 321

Mutation rate

The most accurate method of estimating Y-STR mutation rates is the direct observation
of transmission between father and son. A large scale Y-STR analysis of mutation rates
was performed with 2000 DNA-confirmed father-son pairs and encompassed the
Yfiler® Plus marker set (Ballantyne et al., 2010, 2012, and 2014).
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Table of typical
precision results

Table of Precision Results

Table 8 Example of precision results of seven injections of the Yfiler® Plus Allelic Ladder run on the 3130x/, 3500, and 3500xL
Genetic Analyzers

3130x!( 3500 3500xL
Allele Standard Standard Standard
Mean deviation Mean deviation Mean deviation
DYF38751

30 264.16 - 264.33 | 0.038 - 0.055 264.90 - 264.93 | 0.045 - 0.063 264.85 - 264.89 | 0.038 - 0.057

31 268.02 - 268.20 | 0.035 - 0.054 268.81 - 268.83 | 0.052 - 0.064 268.74 - 268.78 | 0.045 - 0.059

32 271.91 - 272.10 | 0.031 - 0.056 272.69 - 272.72 | 0.042 - 0.053 272.63 - 272.68 | 0.040 - 0.058

33 275.87 - 276.03 | 0.035 - 0.054 276.65 - 276.69 | 0.045 - 0.068 | 276.58 - 276.63 = 0.046 - 0.054

34 279.72 - 279.90 | 0.038 - 0.055 280.54 - 280.58 | 0.049 - 0.072 280.47 - 280.51 | 0.049 - 0.062

35 283.52 - 283.71 | 0.044 - 0.062 284.33 - 284.37 | 0.037 - 0.063 284.26 - 284.30 | 0.049 - 0.057

36 287.35 - 287.55 | 0.043 - 0.054 288.17 - 288.22 | 0.049 - 0.066 288.12 - 288.16 | 0.042 - 0.057

37 291.25 - 291.44 | 0.034 - 0.055 292.10 - 29211 | 0.044 - 0.075  292.01 - 292.06 | 0.042 - 0.062

38 295.03 - 295.22 | 0.043 - 0.065 295.89 - 295.91 | 0.047 - 0.067 295.79 - 295.85 | 0.037 - 0.062

39 299.06 - 299.26 | 0.045 - 0.055 299.93 - 299.96 | 0.064 - 0.068 299.85 - 299.90 | 0.046 - 0.063

40 302.75 - 302.95 | 0.039 - 0.054 303.61 - 303.65 | 0.048 - 0.073 303.52 - 303.60 | 0.047 - 0.065

41 306.64 - 306.86 | 0.035 - 0.066 307.56 - 307.60 | 0.038 - 0.087  307.48 - 307.53 | 0.050 - 0.062

42 310.49 - 310.70 | 0.047 - 0.060 311.44 - 311.47 | 0.062 - 0.080 311.35 - 311.41 | 0.046 - 0.066

43 314.40 - 314.62 | 0.041 - 0.073 315.40 - 315.43 | 0.046 - 0.096 315.30 - 315.37 | 0.045 - 0.070

44 318.47 - 318.69 | 0.039 - 0.062 319.50 - 319.52 | 0.048 - 0.089 319.40 - 319.47 | 0.047 - 0.071

DYS19

9 183.90 - 183.94 | 0.023 - 0.030 184.04 - 184.06 | 0.028 - 0.048 183.99 - 184.01 | 0.026 - 0.039

10 188.07 - 188.11 | 0.022 - 0.036 188.20 - 188.22 | 0.026 - 0.035 188.16 - 188.18 | 0.026 - 0.040

1" 192.11 - 192.13 | 0.026 - 0.036 192.26 - 192.28 | 0.026 - 0.040 192.22 - 192.24 | 0.025 - 0.037

12 196.10 - 196.13 | 0.018 - 0.039 196.24 - 196.27 | 0.032 - 0.046 19621 - 196.23 | 0.032 - 0.041

13 200.17 - 200.21 | 0.019 - 0.034 200.30 - 200.33 | 0.029 - 0.046 200.28 - 200.29 | 0.037 - 0.043

14 204.09 - 204.13 | 0.020 - 0.036 204.24 - 204.27 | 0.027 - 0.038 204.21 - 204.21 | 0.029 - 0.037

15 208.05 - 208.09 | 0.018 - 0.028 208.22 - 208.24 | 0.029 - 0.043 208.16 - 208.18 | 0.027 - 0.038

16 212.03 - 212.05 | 0.023 - 0.032 212.20 - 212.26 | 0.015-0.053  212.15-212.16 | 0.024 - 0.046

17 216.07 - 216.10 | 0.023 - 0.032 216.22 - 216.25 | 0.016 - 0.052 216.18 - 216.20 | 0.029 - 0.044
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3130x! 3500 3500xL

Allele Standard Standard Standard
Mean deviation Mean deviation Mean deviation

18 220.14 - 220.19 | 0.020 - 0.034 220.30 - 220.34 | 0.033 - 0.046 220.27 - 220.29 | 0.020 - 0.043
19 22415 - 224.20 | 0.024 - 0.035 224.34 - 224.35 | 0.040 - 0.058 224.30 - 224.31 | 0.036 - 0.047

DYS385
6 225.25 - 225.31 | 0.029 - 0.041 225.10 - 225.12 | 0.022 - 0.050 225.07 - 225.09 | 0.036 - 0.048
7 229.25 - 229.33 | 0.027 - 0.041 22912 - 229.14 | 0.028 - 0.044 229.08 - 229.11 | 0.042 - 0.047
8 233.37 - 233.44 | 0.026 - 0.042 233.21 - 233.24 | 0.026 - 0.045 233.19 - 233.21 | 0.038 - 0.048
9 237.40 - 237.47 | 0.028 - 0.037 237.24 - 237.26 | 0.023 - 0.066 237.22 - 237.25 | 0.033 - 0.046
10 241.50 - 241.57 | 0.026 - 0.049 24131 - 241.34 | 0.035-0.052 | 241.30 - 241.31 = 0.023 - 0.038
" 245.53 - 245.61 | 0.024 - 0.040 245.37 - 24538 | 0.022 - 0.046 245.34 - 245.37 | 0.031 - 0.046
12 249.71 - 249.81 | 0.027 - 0.038 249.53 - 249.55 | 0.005 - 0.034 249.51 - 249.54 | 0.034 - 0.043
13 253.74 - 253.84 | 0.025 - 0.037 253.55 - 253.57 | 0.021 - 0.040 253.55 - 253.57 | 0.030 - 0.046
14 257.69 - 257.79 | 0.027 - 0.047 257.50 - 257.52 | 0.031 - 0.047  257.51 - 257.52 | 0.028 - 0.041
15 261.66 - 261.75 | 0.023 - 0.039 261.46 - 261.49 | 0.031 - 0.040 261.48 - 261.50 | 0.033 - 0.043
16 265.67 - 265.76 | 0.027 - 0.041 265.50 - 265.51 | 0.018 - 0.044 265.50 - 265.52 | 0.030 - 0.046
17 269.72 - 269.82 | 0.022 - 0.047 269.54 - 269.58 | 0.022 - 0.042 269.55 - 269.57 | 0.036 - 0.046
18 273.73 - 273.83 | 0.026 - 0.045 273.54 - 27358 | 0.027 - 0.055 | 273.54 - 273.57 = 0.029 - 0.047
19 277.83 - 277.93 | 0.025 - 0.046 277.64 - 277.66 | 0.040 - 0.058 277.65 - 277.67 | 0.031 - 0.042
20 281.85 - 281.95 | 0.025 - 0.044 281.66 - 281.70 | 0.035 - 0.044 281.67 - 281.69 | 0.033 - 0.044
21 285.85 - 285.94 | 0.029 - 0.044 285.65 - 285.69 | 0.036 - 0.043 285.67 - 285.68 | 0.030 - 0.043
22 289.82 - 289.93 | 0.029 - 0.052 289.63 - 289.45 | 0.037 - 0.050  289.63 - 289.66 | 0.030 - 0.040
23 293.78 - 293.89 | 0.031 - 0.046 293.58 - 293.62 | 0.030 - 0.040 293.58 - 293.60 | 0.032 - 0.047
24 297.79 - 297.89 | 0.029 - 0.042 297.57 - 297.60 | 0.037 - 0.065 297.56 - 297.60 | 0.034 - 0.050
25 301.75 - 301.85 | 0.025 - 0.052 301.56 - 301.58 | 0.038 - 0.045 301.55 - 301.57 | 0.020 - 0.050
26 305.71 - 305.82 | 0.034 - 0.039 305.51 - 30553 | 0.018-0.054  305.51 - 30553 | 0.026 - 0.039
27 309.71 - 309.82 | 0.036 - 0.044 309.50 - 309.55 | 0.028 - 0.042 309.52 - 309.54 | 0.032 - 0.044
28 313.78 - 313.87 | 0.032 - 0.051 313.53 - 313.58 | 0.005 - 0.051 313.55 - 313.58 | 0.043 - 0.049
DYS389I

9 146.74 - 146.78 | 0.025 - 0.034 146.98 - 147.01 | 0.019 - 0.044 146.81 - 146.84 | 0.025 - 0.042
10 150.83 - 150.87 | 0.026 - 0.033 151.06 - 151.09 | 0.019 - 0.039 150.90 - 150.91 | 0.032 - 0.041
" 154.86 - 154.91 | 0.024 - 0.031 155.09 - 155.11 | 0.030 - 0.042 154.92 - 154.94 | 0.034 - 0.038
12 158.98 - 159.04 | 0.027 - 0.036 159.22 - 159.24 | 0.007 - 0.030 159.04 - 159.07 | 0.021 - 0.035
13 163.19 - 163.26 | 0.020 - 0.031 163.41 - 163.43 | 0.028 - 0.045 | 163.25 - 163.27  0.026 - 0.038
14 167.12 - 167.19 | 0.018 - 0.034 167.33 - 167.35 | 0.015 - 0.030 167.18 - 167.19 | 0.027 - 0.033
15 171.17 - 171.21 | 0.017 - 0.040 171.34 - 171.37 | 0.022 - 0.039 171.21 - 171.22 | 0.021 - 0.038
16 175.19 - 175.24 | 0.020 - 0.025 175.37 - 175.40 | 0.020 - 0.046 175.23 - 175.24 | 0.026 - 0.039
17 179.23 - 179.28 = 0.013 - 0.034 179.40 - 179.41 | 0.005- 0.032  179.25 - 179.27 | 0.041 - 0.045
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3130x! 3500 3500xL
Allele Standard Standard Standard
Mean deviation Mean deviation Mean deviation
DYS389Il

24 265.02 - 265.11 | 0.025 - 0.032 265.16 - 265.20 | 0.023 - 0.060 265.12 - 265.12 | 0.030 - 0.044

25 269.11 - 269.20 | 0.024 - 0.040 269.23 - 269.25 | 0.030 - 0.052 269.17 - 269.18 | 0.030 - 0.042

26 273.08 - 273.17 | 0.021 - 0.043 273.23 - 273.24 | 0.026 - 0.040  273.15 - 273.17 | 0.028 - 0.042

27 277.22 - 277.32 | 0.024 - 0.039 277.36 - 277.39 | 0.036 - 0.054 277.29 - 277.31 | 0.030 - 0.042

28 281.15 - 281.25 | 0.020 - 0.048 281.29 - 281.32 | 0.032 - 0.047 281.21 - 281.22 | 0.034 - 0.043

29 285.01 - 285.10 | 0.019 - 0.041 285.14 - 285.16 | 0.029 - 0.043 285.07 - 285.09 | 0.028 - 0.041

30 289.17 - 289.26 | 0.026 - 0.047 289.31 - 289.33 | 0.027 - 0.039  289.23 - 289.25 | 0.034 - 0.039

31 293.15 - 293.24 | 0.023 - 0.043 293.27 - 293.31 | 0.037 - 0.040 293.19 - 293.21 | 0.023 - 0.037

32 297.02 - 297.11 | 0.027 - 0.035 29714 - 297.15 | 0.029 - 0.059 297.04 - 297.07 | 0.028 - 0.044

33 300.97 - 301.06 | 0.025 - 0.041 301.10 - 301.13 | 0.039 - 0.049 301.02 - 301.03 | 0.037 - 0.043

34 304.81 - 304.89 | 0.024 - 0.035 304.93 - 304.96  0.025-0.060 | 304.85 - 30486  0.031 - 0.038

35 308.89 - 308.97 | 0.027 - 0.041 309.01 - 309.03 | 0.036 - 0.046 308.93 - 308.94 | 0.040 - 0.050
DYS390

17 14414 - 144.23 | 0.026 - 0.044 14414 - 144.19 | 0.038 - 0.042 144.09 - 144.11 | 0.029 - 0.039

18 148.04 - 148.12 | 0.020 - 0.038 148.06 - 148.10 | 0.021 - 0.051  147.98 - 148.01 | 0.035 - 0.043

19 151.96 - 152.04 | 0.026 - 0.037 151.99 - 152.02 | 0.026 - 0.043 151.92 - 151.93 | 0.029 - 0.039

20 156.15 - 156.25 | 0.027 - 0.046 156.16 - 156.20 | 0.026 - 0.041 156.09 - 156.12 | 0.025 - 0.038

21 160.16 - 160.24 | 0.031 - 0.039 160.17 - 160.18 | 0.000 - 0.043 160.09 - 160.10 | 0.025 - 0.037

22 164.21 - 16430 | 0.024 - 0.039 164.21 - 16424 | 0.020 - 0.061  164.15 - 164.17 | 0.030 - 0.041

23 168.34 - 168.42 | 0.026 - 0.039 168.31 - 168.34 | 0.030 - 0.048 168.25 - 168.28 | 0.032 - 0.044

24 172.34 - 172.42 | 0.024 - 0.038 172.30 - 172.32 | 0.032 - 0.055 172.25 - 172.27 | 0.025 - 0.033

25 176.33 - 176.41 | 0.024 - 0.034 176.30 - 176.33 | 0.029 - 0.044 176.24 - 176.26 | 0.027 - 0.037

26 180.35 - 180.44 | 0.023 - 0.036 180.33 - 180.34 | 0.032 - 0.041  180.27 - 180.29 | 0.026 - 0.041

27 184.33 - 184.42 | 0.019 - 0.030 184.32 - 184.34 | 0.040 - 0.052 184.26 - 184.28 | 0.031 - 0.044

28 188.44 - 188.53 | 0.026 - 0.041 188.41 - 188.43 | 0.032 - 0.050 188.36 - 188.38 | 0.029 - 0.043

29 192.49 - 192.58 | 0.027 - 0.042 192.46 - 192.48 | 0.022 - 0.047 192.41 - 192.44 | 0.034 - 0.042
DYS391

5 352.78 - 352.85 | 0.024 - 0.035 353.42 - 353.45 | 0.038 - 0.057 353.34 - 353.36 | 0.034 - 0.049

6 356.84 - 356.91 | 0.032 - 0.042 357.46 - 357.51 | 0.032 - 0.054 357.39 - 357.42 | 0.036 - 0.051

7 360.69 - 360.78 | 0.030 - 0.036 361.40 - 361.43 | 0.026 - 0.057 361.32 - 361.35 | 0.040 - 0.049

8 364.75 - 364.85 | 0.034 - 0.045 365.47 - 36549 | 0.019-0.035 | 365.40 - 365.43 | 0.033 - 0.057

9 368.74 - 368.85 | 0.023 - 0.042 369.47 - 369.50 | 0.024 - 0.060 369.39 - 369.43 | 0.033 - 0.046

10 372.75 - 372.87 | 0.020 - 0.040 373.47 - 373.48 | 0.036 - 0.076 373.40 - 373.44 | 0.032 - 0.050

1" 376.75 - 376.87 | 0.029 - 0.044 377.47 - 377.47 | 0.019 - 0.047 377.38 - 377.42 | 0.037 - 0.044

12 380.81 - 380.90 = 0.031 - 0.052 381.44 - 38148  0.018-0050  381.36 - 381.39 | 0.028 - 0.049
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3130x! 3500 3500xL
Allele Standard Standard Standard
Mean deviation Mean deviation Mean deviation
13 384.93 - 385.02 | 0.029 - 0.045 385.56 - 385.60 | 0.020 - 0.063 385.47 - 385.50 | 0.037 - 0.042
14 388.98 - 389.07 | 0.024 - 0.038 389.60 - 389.62 | 0.023 - 0.050 389.50 - 389.54 | 0.028 - 0.036
15 393.02 - 393.08 | 0.026 - 0.046 393.63 - 393.67 | 0.024 - 0.043 393.55 - 393.57 | 0.033 - 0.045
16 397.05 - 397.12 | 0.031 - 0.042 397.66 - 397.70 | 0.022-0.057 | 397.58 - 397.61 | 0.032 - 0.047
DYS392
4 273.67 - 273.77 | 0.028 - 0.036 274.35 - 274.38 | 0.045 - 0.056 274.25 - 274.28 | 0.039 - 0.047
5 276.63 - 276.74 | 0.027 - 0.044 277.36 - 277.39 | 0.048 - 0.063 277.25 - 277.28 | 0.030 - 0.048
6 279.61 - 279.73 | 0.021 - 0.038 280.32 - 280.35 | 0.033 - 0.051 | 280.22 - 280.25 = 0.045 - 0.054
7 282.64 - 282.75 | 0.023 - 0.032 283.35 - 283.39 | 0.042 - 0.056 283.26 - 283.29 | 0.037 - 0.048
8 285.54 - 285.66 | 0.026 - 0.030 286.23 - 286.25 | 0.050 - 0.065 286.12 - 286.16 | 0.032 - 0.048
9 288.52 - 288.60 | 0.027 - 0.036 289.12 - 289.14 | 0.040 - 0.057 289.00 - 289.04 | 0.034 - 0.044
10 291.25 - 291.38 | 0.026 - 0.040 291.97 - 292.00 | 0.049 - 0.065  291.87 - 291.89 | 0.034 - 0.052
" 294.30 - 294.42 | 0.026 - 0.039 295.04 - 295.05 | 0.051 - 0.072 294.91 - 294.94 | 0.030 - 0.055
12 297.26 - 297.38 | 0.026 - 0.038 297.96 - 297.99 | 0.036 - 0.058 297.84 - 297.88 | 0.035 - 0.058
13 300.19 - 300.30 | 0.031 - 0.045 300.89 - 300.90 | 0.037 - 0.067 300.77 - 300.80 | 0.038 - 0.047
14 303.01 - 303.13 | 0.027 - 0.036 303.73 - 303.74  0.048 - 0.061  303.59 - 303.63 | 0.036 - 0.050
15 306.00 - 306.12 | 0.028 - 0.040 306.70 - 306.74 | 0.043 - 0.070 306.59 - 306.63 | 0.033 - 0.052
16 309.03 - 309.15 | 0.026 - 0.044 309.71 - 309.73 | 0.041 - 0.073 309.58 - 309.62 | 0.038 - 0.053
17 311.93 - 312.06 | 0.027 - 0.044 312.67 - 312.70 | 0.027 - 0.064 312.54 - 312.58 | 0.027 - 0.047
18 314.96 - 315.09 | 0.029 - 0.040 315.75 - 315.77 | 0.019-0.060  315.61 - 315.65 | 0.042 - 0.051
19 318.11 - 318.23 | 0.022 - 0.035 318.88 - 318.90 | 0.028 - 0.056 318.75 - 318.78 | 0.035 - 0.047
20 321.21 - 321.35 | 0.022 - 0.039 321.97 - 322.00 | 0.049 - 0.063 321.84 - 321.88 | 0.027 - 0.058
DYS393
7 90.33 - 90.36 0.021 - 0.032 90.35 - 90.39 0.027 - 0.037 90.23 - 90.25 0.029 - 0.037
8 94.35 - 94.36 0.024 - 0.037 94.37 - 94.42 0.020 - 0.032 94.27 - 94.28 0.033 - 0.041
9 98.51 - 98.53 0.020 - 0.030 98.53 - 98.56 0.028 - 0.039 98.43 - 98.44 0.040 - 0.044
10 102.63 - 102.64 | 0.014 - 0.029 102.67 - 102.70 | 0.021 - 0.052 102.56 - 102.57 | 0.033 - 0.040
" 106.89 - 106.90 | 0.019 - 0.027 106.94 - 106.96 | 0.026 - 0.037 | 106.82 - 106.84 0.029 - 0.037
12 110.79 - 110.81 | 0.024 - 0.030 110.85 - 110.88 | 0.039 - 0.056 110.74 - 110.76 | 0.031 - 0.041
13 114.80 - 114.81 | 0.017 - 0.028 114.87 - 114.91 | 0.020 - 0.041 114.76 - 114.78 | 0.026 - 0.035
14 118.72 - 118.74 | 0.021 - 0.029 118.79 - 118.81 | 0.033 - 0.043 118.67 - 118.69 | 0.010 - 0.032
15 122.51 - 122.53 | 0.024 - 0.036 122.61 - 122.62 | 0.031 - 0.044 12248 - 122.49 | 0.030 - 0.041
16 126.56 - 126.59 | 0.017 - 0.029 126.66 - 126.68 | 0.029 - 0.046 126.54 - 126.56 | 0.036 - 0.041
17 130.54 - 130.55 | 0.015 - 0.033 130.62 - 130.66 | 0.023 - 0.036 130.51 - 130.53 | 0.027 - 0.041
18 134.51 - 134.54 | 0.019 - 0.029 134.61 - 134.64 | 0.025 - 0.038 134.52 - 134.53 | 0.030 - 0.043
DYS437
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3130x! 3500 3500xL

Allele Standard Standard Standard

Mean deviation Mean deviation Mean deviation

10 177.93 - 177.98 | 0.027 - 0.035 178.26 - 178.28 | 0.031 - 0.053 178.20 - 178.22 | 0.030 - 0.047

" 181.97 - 182.01 | 0.026 - 0.036 182.29 - 182.32 | 0.030 - 0.045 182.24 - 182.26 | 0.040 - 0.046

12 186.02 - 186.07 | 0.021 - 0.041 186.35 - 186.38 | 0.027 - 0.041 186.31 - 186.32 | 0.031 - 0.046

13 189.98 - 190.02 | 0.020 - 0.039 190.28 - 190.31 | 0.020 - 0.051  190.24 - 190.26 | 0.033 - 0.043

14 194.03 - 194.07 = 0.023 - 0.041 194.34 - 194.37 | 0.028 - 0.049 194.29 - 194.31 | 0.041 - 0.044

15 198.15 - 198.20 = 0.025 - 0.031 198.49 - 198.51 | 0.017 - 0.040 198.46 - 198.47 | 0.035 - 0.046

16 202.13 - 202.19 | 0.030 - 0.037 202.47 - 202.50 | 0.026 - 0.047 202.44 - 202.45 | 0.035 - 0.041

17 206.08 - 206.12 | 0.023 - 0.034 206.42 - 20645 | 0.026 - 0.056  206.36 - 206.38 | 0.033 - 0.040

18 210.03 - 210.07 | 0.022 - 0.036 210.38 - 210.41 | 0.031 - 0.054 210.33 - 210.35 | 0.038 - 0.045
DYS438

6 207.14 - 207.22 | 0.024 - 0.032 207.69 - 207.73 | 0.044 - 0.059 207.67 - 207.68 | 0.033 - 0.040

7 212.16 - 212.22 | 0.025 - 0.032 212.70 - 212.71 | 0.030 - 0.049 | 212.66 - 212.68 = 0.030 - 0.054

8 217.23 - 217.31 | 0.022 - 0.038 217.78 - 217.82 | 0.029 - 0.050 217.76 - 217.77 | 0.032 - 0.038

9 222.32 - 222.41 | 0.023 - 0.032 222.87 - 222.90 | 0.023 - 0.064 222.86 - 222.87 | 0.030 - 0.040

10 227.38 - 227.47 | 0.027 - 0.030 227.91 - 227.94 | 0.016 - 0.068 227.90 - 227.93 | 0.036 - 0.054

" 232.43 - 232.52 | 0.032 - 0.037 232.96 - 232.98 | 0.031-0.065  232.95-232.98 | 0.032 - 0.046

12 237.48 - 237.58 | 0.021 - 0.038 238.03 - 238.04 | 0.035 - 0.047 238.00 - 238.03 | 0.032 - 0.049

13 242.64 - 242.71 | 0.024 - 0.033 243.14 - 243.17 | 0.027 - 0.052 243.14 - 243.16 | 0.025 - 0.037

14 247.82 - 247.87 | 0.022 - 0.031 248.30 - 248.32 | 0.040 - 0.050 248.28 - 248.31 | 0.033 - 0.046

15 252.87 - 252.90 | 0.022 - 0.037 253.31 - 253.33 | 0.027 - 0.056  253.31 - 253.34 | 0.024 - 0.041

16 257.80 - 257.85 | 0.014 - 0.029 258.24 - 258.26 | 0.021 - 0.041 258.24 - 258.27 | 0.034 - 0.039
DYS439

6 149.93 - 150.01 | 0.016 - 0.027 150.28 - 150.31 | 0.021 - 0.046 150.23 - 150.24 | 0.028 - 0.039

7 154.05 - 154.12 | 0.020 - 0.036 154.38 - 15441 | 0.033 - 0.055 15432 - 15434 | 0.034 - 0.041

8 158.15 - 158.23 | 0.031 - 0.036 158.51 - 158.52 | 0.031 - 0.052 158.43 - 158.46 | 0.025 - 0.046

9 162.21 - 162.30 | 0.024 - 0.034 162.54 - 162.59 | 0.036 - 0.046 162.49 - 162.50 | 0.036 - 0.043

10 166.33 - 166.41 | 0.023 - 0.029 166.65 - 166.69 | 0.033 - 0.039 166.60 - 166.62 | 0.026 - 0.044

1" 170.27 - 170.36 | 0.022 - 0.032 170.60 - 170.64 | 0.039 - 0.054  170.56 - 170.59 | 0.027 - 0.045

12 174.30 - 174.39 | 0.020 - 0.032 174.64 - 174.67 | 0.029 - 0.050 174.58 - 174.61 | 0.028 - 0.045

13 178.38 - 178.47 | 0.027 - 0.047 178.72 - 178.75 | 0.032 - 0.052 178.66 - 178.70 | 0.041 - 0.046

14 182.44 - 182.52 | 0.029 - 0.035 182.78 - 182.81 | 0.035 - 0.051 182.74 - 182.76 | 0.025 - 0.045

15 186.45 - 186.53 | 0.024 - 0.033 186.79 - 186.82 | 0.029 - 0.052 | 186.76 - 186.78 = 0.036 - 0.044

16 190.51 - 190.60 | 0.025 - 0.042 190.86 - 190.88 | 0.026 - 0.048 190.83 - 190.85 | 0.037 - 0.047

17 194.58 - 194.66 | 0.024 - 0.040 194.93 - 194.96 | 0.027 - 0.054 194.90 - 194.93 | 0.034 - 0.047
DYS448

14 277.79 - 277.88 | 0.032 - 0.045 278.38 - 278.41 | 0.033 - 0.059 278.39 - 278.41 | 0.040 - 0.063
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3130x! 3500 3500xL

Allele Standard Standard Standard
Mean deviation Mean deviation Mean deviation

15 283.72 - 283.80 | 0.021 - 0.044 284.33 - 284.34 | 0.030 - 0.065 284.31 - 284.34 | 0.034 - 0.048
16 289.61 - 289.69 | 0.033 - 0.043 290.22 - 290.25 | 0.031 - 0.062 290.21 - 290.24 | 0.031 - 0.050
17 295.50 - 295.59 | 0.031 - 0.045 296.12 - 296.14 | 0.039 - 0.060 296.11 - 296.13 | 0.039 - 0.059
18 301.34 - 301.43 | 0.036 - 0.043 301.98 - 302.00 = 0.040 - 0.061  301.95 - 302.00 | 0.040 - 0.064
19 307.17 - 307.28 | 0.035 - 0.043 307.85 - 307.88 | 0.042 - 0.061 307.83 - 307.87 | 0.037 - 0.050
20 313.18 - 313.29 | 0.038 - 0.048 313.87 - 313.91 | 0.051 - 0.079 313.86 - 313.90 | 0.040 - 0.060
21 319.33 - 319.45 | 0.036 - 0.049 320.06 - 320.09 | 0.035 - 0.052 320.06 - 320.10 | 0.039 - 0.066
22 325.50 - 325.63 | 0.041 - 0.053 32621 - 32623 | 0.038-0062  326.22 - 326.26 | 0.049 - 0.060
23 331.46 - 331.61 | 0.036 - 0.056 332.16 - 332.19 | 0.039 - 0.070 332.16 - 332.20 | 0.045 - 0.066
24 337.39 - 337.53 | 0.038 - 0.051 338.10 - 338.14 | 0.024 - 0.077 338.11 - 338.15 | 0.040 - 0.060

DYS449
22 325.50 - 325.57 | 0.027 - 0.062 325.58 - 325.61 | 0.037 - 0.049 325.63 - 325.67 | 0.035 - 0.049
23 329.59 - 329.64 | 0.027 - 0.064 329.65 - 329.67 | 0.028 - 0.054 329.71 - 329.73 | 0.039 - 0.060
24 333.63 - 333.66 | 0.025 - 0.062 333.66 - 333.72 | 0.025 - 0.041 333.75 - 333.76 | 0.032 - 0.045
25 337.66 - 337.69 | 0.031 - 0.058 337.68 - 337.72 | 0.033 - 0.045 337.76 - 337.78 | 0.027 - 0.040
26 341.49 - 341.75 | 0.029 - 0.052 341.72 - 341.77 | 0.025-0.042  341.79 - 341.81 | 0.039 - 0.051
27 345.76 - 345.87 | 0.029 - 0.050 345.80 - 345.84 | 0.031 - 0.049 345.87 - 345.88 | 0.032 - 0.043
28 349.82 - 349.93 | 0.028 - 0.061 349.87 - 349.89 | 0.018 - 0.051 349.93 - 349.94 | 0.029 - 0.039
29 353.87 - 353.98 | 0.025 - 0.053 353.92 - 353.95 | 0.020 - 0.060 353.98 - 353.99 | 0.034 - 0.044
30 357.92 - 358.03 | 0.028 - 0.060 357.97 - 358.00 | 0.027 - 0.042  358.03 - 358.06 | 0.035 - 0.050
31 361.97 - 362.04 | 0.036 - 0.045 362.01 - 362.04 | 0.021 - 0.040 362.07 - 362.09 | 0.032 - 0.059
32 365.98 - 366.06 | 0.034 - 0.042 366.01 - 366.04 | 0.038 - 0.055 366.08 - 366.10 | 0.035 - 0.041
33 369.99 - 370.07 | 0.029 - 0.042 370.00 - 370.04 | 0.038 - 0.048 370.08 - 370.11 | 0.030 - 0.047
34 373.99 - 374.09 = 0.025 - 0.044 374.02 - 374.04 = 0.027 - 0.061  374.09 - 37412 | 0.033 - 0.053
35 377.99 - 378.08 | 0.032 - 0.047 378.01 - 378.06 | 0.040 - 0.055 378.10 - 378.11 | 0.039 - 0.047
36 382.03 - 382.12 | 0.034 - 0.043 382.03 - 382.08 | 0.027 - 0.053 382.12 - 382.13 | 0.031 - 0.051
37 386.08 - 386.18 | 0.022 - 0.043 386.09 - 386.12 | 0.025 - 0.045 386.17 - 386.19 | 0.034 - 0.048
38 390.12 - 390.22 | 0.020 - 0.042 390.14 - 390.16 | 0.025- 0.044 | 390.21 - 390.23 | 0.036 - 0.044
39 394.14 - 394.28 | 0.030 - 0.043 394.18 - 394.20 | 0.029 - 0.049 394.24 - 394.26 | 0.037 - 0.043
40 398.17 - 398.31 | 0.029 - 0.053 398.21 - 398.25 | 0.024 - 0.047 398.27 - 398.29 | 0.030 - 0.038
DYS456

10 76.25 - 76.30 0.033 - 0.043 76.25 - 76.28 0.044 - 0.050 76.08 - 76.10 0.031 - 0.042
" 80.51 - 80.56 0.016 - 0.036 80.54 - 80.56 0.025 - 0.047 80.40 - 80.42 0.026 - 0.037
12 84.72 - 84.78 0.023 - 0.035 84.74 - B4.TT 0.009 - 0.043 84.63 - 84.64 0.028 - 0.035
13 88.92 - 88.97 0.020 - 0.036 88.95 - 88.99 0.021 - 0.035 88.84 - 88.85 0.024 - 0.036
14 93.11-93.16 | 0.022 - 0.036 93.13 - 93.17 0.024 - 0.047 | 93.03 - 93.05 0.028 - 0.039
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Appendix ATable of Precision Results

3130x! 3500 3500xL

Allele Standard Standard Standard

Mean deviation Mean deviation Mean deviation

15 97.28 - 97.34 0.024 - 0.037 97.30 - 97.35 0.027 - 0.038 97.23 - 97.24 0.021 - 0.035

16 101.47 - 101.53 | 0.022 - 0.031 101.52 - 101.55 | 0.010 - 0.033 101.42 - 101.43 | 0.034 - 0.040

17 105.65 - 105.72 | 0.021 - 0.030 105.73 - 105.75 | 0.025 - 0.038 105.62 - 105.64 | 0.023 - 0.035

18 109.81 - 109.88 | 0.022 - 0.037 109.89 - 109.92 | 0.023 - 0.056 | 109.77 - 109.80  0.027 - 0.038

19 113.92 - 113.98 | 0.029 - 0.032 114.01 - 114.04 | 0.028 - 0.060 113.89 - 113.91 | 0.032 - 0.038

20 117.90 - 117.95 | 0.022 - 0.035 118.01 - 118.02 | 0.026 - 0.044 117.88 - 117.88 | 0.022 - 0.029

21 121.86 - 121.93 | 0.022 - 0.036 121.97 - 122.01 | 0.040 - 0.044 121.84 - 121.86 | 0.036 - 0.042

22 125.85 - 125.93 | 0.027 - 0.033 125.98 - 126.00 | 0.032 - 0.048 | 125.85 - 125.87 0.032 - 0.038

23 129.87 - 129.94 | 0.029 - 0.033 130.00 - 130.04 | 0.042 - 0.058 129.88 - 129.89 | 0.032 - 0.040

24 133.89 - 133.96 | 0.026 - 0.033 134.04 - 134.05 | 0.030 - 0.041 133.92 - 133.94 | 0.024 - 0.044
DYS458

1" 119.84 - 119.98 | 0.027 - 0.034 120.25 - 120.28 | 0.039 - 0.065 120.11 - 120.13 | 0.039 - 0.041

12 123.66 - 123.81 | 0.026 - 0.038 124.10 - 124.13 | 0.042 - 0.056 123.96 - 123.98 | 0.026 - 0.040

13 127.52 - 127.66 | 0.025 - 0.041 127.97 - 128.01 | 0.035 - 0.053 127.82 - 127.85 | 0.027 - 0.040

14 131.37 - 131.53 | 0.033 - 0.038 131.84 - 131.90 | 0.040 - 0.069 131.70 - 131.74 | 0.024 - 0.041

15 135.26 - 135.41 | 0.020 - 0.043 135.77 - 135.80 | 0.035- 0.059 | 135.62 - 135.65 0.030 - 0.038

16 139.17 - 139.32 | 0.027 - 0.046 139.68 - 139.72 | 0.041 - 0.051 139.56 - 139.58 | 0.028 - 0.044

17 143.06 - 143.24 | 0.030 - 0.044 143.61 - 143.64 | 0.028 - 0.049 143.47 - 143.52 | 0.030 - 0.040

18 147.14 - 147.31 | 0.030 - 0.045 147.70 - 147.72 | 0.033 - 0.054 147.56 - 147.59 | 0.035 - 0.047

19 151.22 - 151.39 | 0.029 - 0.050 151.77 - 151.83 | 0.040 - 0.060  151.65 - 151.68 | 0.034 - 0.043

20 155.22 - 155.39 | 0.028 - 0.047 155.79 - 155.82 | 0.031 - 0.062 155.65 - 155.68 | 0.029 - 0.049

21 159.12 - 159.30 | 0.028 - 0.049 159.71 - 159.73 | 0.028 - 0.041 159.57 - 159.61 | 0.027 - 0.042

22 163.07 - 163.26 | 0.027 - 0.050 163.65 - 163.69 | 0.039 - 0.063 163.52 - 163.55 | 0.035 - 0.048

23 166.99 - 167.18 | 0.019 - 0.060 167.58 - 167.61 | 0.028 - 0.059  167.45 - 167.48 | 0.030 - 0.042

24 170.92 - 171.11 | 0.028 - 0.064 171.52 - 171.54 | 0.042 - 0.063 171.38 - 171.42 | 0.033 - 0.044
DYS460

7 79.58 - 79.61 0.031 - 0.038 79.58 - 79.60 0.053 - 0.060 79.38 - 79.40 0.023 - 0.039

8 83.76 - 83.80 | 0.021 - 0.040 83.75 - 83.78 0.042 - 0.058 | 83.58 - 83.40 0.026 - 0.037

9 87.96 - 87.98 0.025 - 0.037 87.92 - 87.97 0.027 - 0.035 87.77 - 87.79 0.029 - 0.038

10 9212 - 92.15 0.024 - 0.042 92.10 - 92.13 0.023 - 0.043 91.95 - 91.97 0.031 - 0.044

1" 96.29 - 96.31 0.028 - 0.041 96.26 - 96.30 0.030 - 0.049 96.11 - 96.13 0.030 - 0.040

12 100.46 - 100.48 | 0.023 - 0.045 100.44 - 100.48 | 0.039 - 0.048  100.28 - 100.30 | 0.034 - 0.042

13 104.65 - 104.67 | 0.028 - 0.035 104.64 - 104.67 | 0.030 - 0.038 104.48 - 104.50 | 0.025 - 0.039

14 108.80 - 108.84 | 0.028 - 0.039 108.79 - 108.82 | 0.025 - 0.040 108.63 - 108.66 | 0.027 - 0.033
DYS481

17 206.82 - 206.84 | 0.018 - 0.034 206.89 - 206.93 | 0.023 - 0.040 206.96 - 206.97 | 0.025 - 0.038
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3130x! 3500 3500xL

Allele Standard Standard Standard
Mean deviation Mean deviation Mean deviation

18 209.80 - 209.81 | 0.018 - 0.032 209.86 - 209.88 | 0.027 - 0.044 209.92 - 209.93 | 0.030 - 0.036
19 212.76 - 212.78 | 0.026 - 0.036 212.86 - 212.87 | 0.009 - 0.050 212.89 - 212.91 | 0.037 - 0.045
20 215.78 - 215.80 | 0.021 - 0.035 215.86 - 215.88 | 0.016 - 0.042 215.91 - 215.94 | 0.027 - 0.042
21 218.85 - 218.87 | 0.018 - 0.033 218.91 - 21894 | 0.010-0.032  218.98 - 218.99 | 0.029 - 0.040
22 221.88 - 221.90 = 0.024 - 0.039 221.93 - 221.96 | 0.020 - 0.042 222.00 - 222.02 = 0.038 - 0.048
23 224.88 - 224.90 | 0.023 - 0.033 224.94 - 224.97 | 0.025 - 0.037 225.02 - 225.03 | 0.039 - 0.049
24 227.88 - 227.90 | 0.021 - 0.032 227.95 - 227.97 | 0.037 - 0.055 228.03 - 228.04 | 0.037 - 0.043
25 230.90 - 230.92 | 0.017 - 0.034 230.96 - 230.99 | 0.035-0.054  231.03 - 231.04 | 0.030 - 0.049
26 233.91 - 233.93 | 0.022 - 0.033 233.97 - 233.98 | 0.027 - 0.049 234.04 - 234.06 | 0.032 - 0.042
27 236.91 - 236.93 | 0.018 - 0.034 236.98 - 237.00 = 0.023 - 0.053 237.06 - 237.07 | 0.033 - 0.037
28 239.94 - 239.95 | 0.023 - 0.033 239.99 - 240.01 | 0.000 - 0.048 240.07 - 240.08 | 0.026 - 0.048
29 243.03 - 243.05 | 0.023 - 0.031 243.08 - 243.10 | 0.026 - 0.046 | 243.15 - 24316 | 0.030 - 0.034
30 24611 - 246.13 | 0.023 - 0.031 24614 - 246.16 | 0.025 - 0.052 246.21 - 246.23 | 0.029 - 0.040
31 24917 - 249.21 | 0.023 - 0.032 249.18 - 249.21 | 0.009 - 0.038 249.27 - 249.28 | 0.030 - 0.038
32 252.15 - 252.20 | 0.025 - 0.033 252.19 - 252.20 | 0.020 - 0.045 252.27 - 252.28 | 0.029 - 0.039

DYS518
32 332.35 - 332.38 | 0.025 - 0.054 332.32 - 332.35 | 0.027 - 0.045 332.32 - 332.35 | 0.038 - 0.046
33 336.40 - 336.41 | 0.029 - 0.050 336.35 - 336.38 | 0.024 - 0.045 336.36 - 336.39 | 0.030 - 0.050
34 340.43 - 340.48 | 0.026 - 0.047 340.36 - 340.40 | 0.005 - 0.044 340.39 - 340.41 | 0.005 - 0.041
35 344.52 - 34459 | 0.025 - 0.051 344.45 - 34449 | 0.032-0051 | 34448 - 34450 | 0.035 - 0.052
36 348.60 - 348.70 | 0.024 - 0.047 348.54 - 348.57 | 0.011 - 0.044 348.56 - 348.59 | 0.027 - 0.042
37 352.67 - 352.76 | 0.025 - 0.059 352.60 - 352.64 | 0.033 - 0.053 352.63 - 352.65 | 0.029 - 0.042
38 356.74 - 356.82 | 0.026 - 0.054 356.69 - 356.71 | 0.038 - 0.049 356.70 - 356.73 | 0.038 - 0.054
39 360.82 - 360.88 = 0.025 - 0.044 360.73 - 360.77 | 0.036 - 0.049 | 360.77 - 360.79 | 0.035 - 0.058
40 364.83 - 364.91 | 0.021 - 0.043 364.76 - 364.78 | 0.026 - 0.046 364.80 - 364.82 | 0.030 - 0.041
41 368.87 - 368.92 | 0.021 - 0.036 368.78 - 368.80 | 0.032 - 0.059 368.82 - 368.84 | 0.035 - 0.046
42 372.87 - 372.94 | 0.030 - 0.038 372.78 - 372.83 | 0.033 - 0.043 372.83 - 372.85 | 0.030 - 0.041
43 376.91 - 376.98 | 0.026 - 0.043 376.81 - 376.83 | 0.026 - 0.057  376.84 - 376.88 | 0.038 - 0.053
L4 380.95 - 381.01 | 0.024 - 0.034 380.83 - 380.86 | 0.041 - 0.052 380.88 - 380.89 | 0.030 - 0.049
45 385.00 - 385.07 | 0.024 - 0.038 384.89 - 384.92 | 0.019 - 0.045 384.93 - 384.95 | 0.029 - 0.046
46 389.05 - 389.14 | 0.027 - 0.035 388.96 - 388.97 | 0.026 - 0.054 388.99 - 389.00 | 0.038 - 0.048
47 393.09 - 393.19 | 0.023 - 0.043 393.00 - 393.02 | 0.033-0.049  393.04 - 393.06 | 0.025 - 0.053
48 397.12 - 397.24 | 0.034 - 0.047 397.04 - 397.08 | 0.028 - 0.054 397.08 - 397.12 | 0.031 - 0.052
49 401.16 - 401.26 | 0.025 - 0.039 401.08 - 401.10 | 0.018 - 0.041 401.10 - 401.13 | 0.031 - 0.051
DYS533
7 338.37 - 338.42 | 0.028 - 0.035 338.61 - 338.63 | 0.036 - 0.049 338.55 - 338.56 | 0.020 - 0.036
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Allele Standard Standard Standard
Mean deviation Mean deviation Mean deviation

8 342.44 - 342.48 | 0.024 - 0.040 342.64 - 342.69 | 0.027 - 0.043 342.61 - 342.62 | 0.040 - 0.046

9 346.54 - 346.56 | 0.026 - 0.038 346.72 - 346.77 | 0.028 - 0.044 346.68 - 346.70 | 0.032 - 0.047
10 350.61 - 350.63 | 0.026 - 0.039 350.82 - 350.85 | 0.026 - 0.053 350.75 - 350.76 | 0.033 - 0.048
1" 354.68 - 354.69 | 0.024 - 0.035 354.87 - 354.91 | 0.024- 0037 35481 - 35483 | 0.028 - 0.051
12 358.73 - 358.77 | 0.026 - 0.035 358.93 - 358.97 | 0.015 - 0.059 358.88 - 358.90 | 0.029 - 0.046
13 362.76 - 362.78 | 0.023 - 0.035 362.96 - 362.99 | 0.018 - 0.043 362.90 - 362.93 | 0.028 - 0.045
14 366.76 - 366.79 | 0.021 - 0.035 366.95 - 366.99 | 0.029 - 0.048 366.92 - 366.95 | 0.034 - 0.043
15 370.78 - 370.82 = 0.022 - 0.029 370.99 - 371.01 | 0.032-0.064 | 370.94 - 370.97 | 0.031 - 0.048
16 374.79 - 374.82 | 0.033 - 0.034 374.99 - 375.02 | 0.030 - 0.047 374.93 - 374.96 | 0.035 - 0.047
17 378.80 - 378.83 | 0.025 - 0.039 379.01 - 379.03 | 0.010 - 0.045 378.94 - 378.97 | 0.041 - 0.049

DYS570
10 97.99 - 98.02 0.021 - 0.034 98.02 - 98.04 0.026 - 0.044 97.95 - 97.96 0.035 - 0.043
" 102.12 - 102.15 | 0.024 - 0.034 102.13 - 102.16 | 0.023 - 0.041 102.08 - 102.09 | 0.028 - 0.034
12 106.23 - 106.27 | 0.021 - 0.029 106.26 - 106.29 | 0.032 - 0.046 106.20 - 106.21 | 0.026 - 0.036
13 110.33 - 110.35 | 0.022 - 0.033 110.35 - 110.37 | 0.032 - 0.044 110.28 - 110.30 | 0.028 - 0.043
14 11436 - 114.38 | 0.018 - 0.030 114.40 - 11441 | 0024 -0.038 | 11432 - 11434 0.017 - 0.037
15 118.29 - 118.32 | 0.021 - 0.030 118.32 - 118.34 | 0.022 - 0.037 118.23 - 118.25 | 0.035 - 0.038
16 122.21 - 122.24 | 0.023 - 0.041 122.23 - 122.26 | 0.032 - 0.041 122.15 - 122.17 | 0.027 - 0.036
17 126.18 - 126.21 | 0.026 - 0.041 126.21 - 126.22 | 0.030 - 0.042 126.13 - 126.14 | 0.027 - 0.042
18 130.16 - 130.19 | 0.021 - 0.041 130.18 - 130.20 | 0.015- 0.039 | 130.11 - 130.12  0.028 - 0.034
19 134.15 - 134.19 | 0.027 - 0.038 134.18 - 134.21 | 0.025 - 0.038 134.11 - 134.13 | 0.026 - 0.041
20 138.19 - 138.23 | 0.026 - 0.043 138.20 - 138.25 | 0.027 - 0.046 138.14 - 138.16 | 0.027 - 0.036
21 142.27 - 142.30 | 0.024 - 0.033 142.29 - 142.31 | 0.024 - 0.037 142.23 - 142.25 | 0.034 - 0.040
22 14638 - 146.42 | 0.021 - 0.028 14639 - 146.42 | 0.020 - 0.033 | 146.34 - 14635  0.028 - 0.038
23 150.50 - 150.55 | 0.027 - 0.031 150.49 - 150.51 | 0.035 - 0.046 150.45 - 150.47 | 0.025 - 0.039
24 154.62 - 154.67 | 0.023 - 0.040 154.61 - 154.64 | 0.027 - 0.039 154.57 - 154.60 | 0.027 - 0.036
25 158.75 - 158.81 | 0.024 - 0.038 158.73 - 158.75 | 0.034 - 0.038 158.69 - 158.70 | 0.016 - 0.029
26 162.84 - 162.88 | 0.027 - 0.042 162.80 - 162.82 | 0.019 - 0.042  162.76 - 162.79 | 0.031 - 0.040
DYS576
10 72.26 - 72.37 0.028 - 0.050 72.79 - 72.82 0.041 - 0.073 72.45 - 72.47 0.038 - 0.045
1" 76.42 - 76.55 0.027 - 0.043 77.02 - 77.03 0.059 - 0.066 76.69 - 76.71 0.028 - 0.047
12 80.56 - 80.68 | 0.020 - 0.038 81.18 - 81.20 0.039 - 0.064 | 80.88 - 80.89 0.036 - 0.040
13 84.65 - 84.77 0.021 - 0.033 85.27 - 85.30 0.040 - 0.052 84.98 - 85.01 0.031 - 0.037
14 88.71 - 88.86 0.029 - 0.041 89.35 - 89.38 0.040 - 0.068 89.07 - 89.10 0.029 - 0.040
15 92.79 - 92.93 0.026 - 0.043 93.42 - 93.47 0.039 - 0.057 93.17 - 93.19 0.024 - 0.040
16 96.84 - 96.99 | 0.029 - 0.039 97.49 - 97.54 0.041-0.055 | 97.24 - 97.26 0.029 - 0.040
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17 100.90 - 101.05 | 0.021 - 0.045 101.59 - 101.63 | 0.027 - 0.051 101.34 - 101.35 | 0.038 - 0.039
18 104.98 - 105.14 | 0.029 - 0.040 105.69 - 105.72 | 0.038 - 0.069 105.41 - 105.44 | 0.026 - 0.037
19 109.02 - 109.19 | 0.026 - 0.053 109.73 - 109.77 | 0.033 - 0.071 109.47 - 109.49 | 0.025 - 0.043
20 113.02 - 113.20 | 0.025 - 0.050 113.76 - 113.79 | 0.037-0.080 11349 - 113.50 | 0.034 - 0.040
21 116.93 - 117.09 | 0.029 - 0.042 117.65 - 117.67 | 0.033 - 0.065 117.38 - 117.40 | 0.031 - 0.040
22 120.77 - 120.95 | 0.025 - 0.042 121.51 - 121.54 | 0.042 - 0.074 121.23 - 121.27 | 0.026 - 0.041
23 124.66 - 124.83 | 0.029 - 0.042 125.43 - 125.46 | 0.041 - 0.081 125.14 - 125.17 | 0.030 - 0.039
24 128.56 - 128.74 | 0.030 - 0.050 129.36 - 129.38 | 0.062 - 0.069  129.07 - 129.09 | 0.028 - 0.040
25 132.47 - 132.66 | 0.025 - 0.042 133.28 - 133.32 | 0.035 - 0.072 132.99 - 133.04 | 0.029 - 0.036

DYS627
" 323.89 - 324.05 | 0.049 - 0.059 325.01 - 325.03 | 0.048 - 0.094 324.93 - 324.98 | 0.052 - 0.066
12 327.79 - 327.94 | 0.043 - 0.066 328.92 - 328.97  0.038-0.095 | 328.84 - 328.89 | 0.058 - 0.074
13 331.66 - 331.84 | 0.033 - 0.053 332.81 - 332.85 | 0.053 - 0.080 332.73 - 332.77 | 0.048 - 0.070
14 335.53 - 335.71 | 0.046 - 0.062 336.67 - 336.72 | 0.045 - 0.086 336.61 - 336.65 | 0.055 - 0.063
15 339.38 - 339.53 | 0.040 - 0.056 340.53 - 340.57 | 0.054 - 0.086 340.45 - 340.50 | 0.044 - 0.070
16 343.29 - 343.42 | 0.040 - 0.055 344.42 - 34447 | 0.025-0103 | 344.35 - 344.42 | 0.048 - 0.056
17 347.21 - 347.32 | 0.040 - 0.060 348.36 - 348.40 | 0.050 - 0.101 348.28 - 348.33 | 0.047 - 0.059
18 351.11 - 351.22 | 0.037 - 0.061 352.27 - 352.31 | 0.052 - 0.097 352.19 - 352.24 | 0.050 - 0.071
19 355.07 - 355.22 | 0.047 - 0.062 356.26 - 356.29 | 0.050 - 0.098 356.17 - 356.23 | 0.046 - 0.063
20 358.90 - 359.06 = 0.047 - 0.060 360.11 - 360.17 | 0.048 - 0.114  360.02 - 360.10 | 0.053 - 0.072
21 362.69 - 362.85 | 0.038 - 0.064 363.92 - 363.94 | 0.059 - 0.092 363.83 - 363.90 | 0.053 - 0.066
22 366.53 - 366.69 | 0.049 - 0.070 367.77 - 367.80 | 0.040 - 0.095 367.69 - 367.75 | 0.051 - 0.067
23 370.36 - 370.53 | 0.045 - 0.064 371.62 - 371.66 | 0.044 - 0.075 371.53 - 371.61 | 0.054 - 0.064
24 374.21 - 37437 | 0.054 - 0.069 37547 - 37552 | 0.074-0.077  375.39 - 375.46 | 0.062 - 0.070
25 378.05 - 378.21 | 0.059 - 0.074 379.32 - 379.36 | 0.055 - 0.067 379.23 - 379.32 | 0.058 - 0.067
26 381.90 - 382.06 | 0.062 - 0.080 383.22 - 383.27 | 0.059 - 0.086 383.12 - 383.20 | 0.056 - 0.074
27 385.79 - 385.94 | 0.064 - 0.079 387.10 - 387.14 | 0.069 - 0.094 387.02 - 387.10 | 0.046 - 0.073
DYS635
15 191.34 - 191.39 | 0.026 - 0.034 191.90 - 191.92 | 0.036 - 0.052 191.76 - 191.77 | 0.034 - 0.046
16 195.40 - 195.44 | 0.024 - 0.038 195.95 - 195.98 | 0.030 - 0.049 195.82 - 195.83 | 0.033 - 0.047
17 199.45 - 199.49 | 0.025 - 0.036 200.00 - 200.01 | 0.000 - 0.056 199.87 - 199.88 | 0.042 - 0.046
18 203.42 - 203.46 | 0.020 - 0.036 203.96 - 203.98 | 0.021 - 0.048  203.82 - 203.83 = 0.031 - 0.044
19 207.37 - 207.41 | 0.021 - 0.038 207.92 - 207.94 | 0.022 - 0.040 207.77 - 207.79 | 0.030 - 0.040
20 211.35 - 211.38 | 0.027 - 0.036 211.89 - 211.91 | 0.017 - 0.060 211.75 - 211.77 | 0.034 - 0.041
21 215.41 - 215.44 | 0.022 - 0.034 215.96 - 215.99 | 0.016 - 0.059 215.82 - 215.83 | 0.030 - 0.052
22 219.43 - 219.48 | 0.027 - 0.039 219.99 - 220.01 | 0.000 - 0.048  219.85 - 219.87 | 0.045 - 0.046
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3130x! 3500 3500xL

Allele Standard Standard Standard
Mean deviation Mean deviation Mean deviation

23 223.44 - 223.49 | 0.023 - 0.037 224.00 - 224.02 | 0.033 - 0.061 223.86 - 223.89 | 0.038 - 0.053
24 227.31 - 227.38 | 0.024 - 0.036 227.88 - 227.92 | 0.034 - 0.051 227.76 - 227.77 | 0.034 - 0.043
25 231.45 - 231.52 | 0.023 - 0.036 232.03 - 232.06 | 0.034 - 0.064 231.91 - 231.93 | 0.037 - 0.050
26 235.35 - 235.42 | 0.021 - 0.030 235.93 - 235.95 | 0.039 - 0.053  235.81 - 235.84 | 0.032 - 0.042
27 239.49 - 239.55 | 0.032 - 0.036 240.07 - 240.09 | 0.000 - 0.058 239.95 - 239.97 | 0.043 - 0.046
28 243.60 - 243.65 | 0.026 - 0.038 24417 - 244.19 | 0.023 - 0.035 244.05 - 244.09 | 0.031 - 0.048
29 247.70 - 247.75 | 0.022 - 0.032 248.24 - 248.27 | 0.017 - 0.039 248.14 - 248.17 | 0.038 - 0.046
30 251.73 - 251.77 | 0.021 - 0.037 252.25 - 252.29 | 0.020 - 0.052  252.14 - 252.18 | 0.032 - 0.045

YGATAH4

8 235.91 - 235.96 | 0.022 - 0.032 236.18 - 236.22 | 0.031 - 0.055 236.15 - 236.16 | 0.030 - 0.047

9 239.92 - 239.96 | 0.023 - 0.036 240.19 - 240.22 | 0.031 - 0.065 240.16 - 240.18 | 0.028 - 0.055
10 244.04 - 244.09 | 0.023 - 0.030 24431 - 24434 | 0.033 - 0.047 24427 - 244.28 | 0.030 - 0.046
" 248.14 - 248.15 | 0.018 - 0.033 248.39 - 248.41 | 0.041 - 0.052 248.35 - 248.36 | 0.032 - 0.047
12 252.15 - 252.17 | 0.020 - 0.034 252.37 - 252.39 | 0.020 - 0.040 252.35 - 252.37 | 0.031 - 0.040
13 256.07 - 256.10 | 0.024 - 0.039 256.31 - 256.33 | 0.029 - 0.039 256.28 - 256.30 | 0.027 - 0.042
14 259.97 - 260.00 | 0.015 - 0.032 260.24 - 260.27 | 0.000 - 0.049 | 260.19 - 260.23 = 0.032 - 0.047
15 263.94 - 263.99 | 0.019 - 0.042 264.22 - 264.25 | 0.019 - 0.040 264.20 - 264.22 | 0.034 - 0.045
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Troubleshooting

Follow the actions recommended in this appendix to troubleshoot problems that occur

during analysis.

Table 9 Troubleshooting

Observation Possible causes

Recommended actions

Incorrect volume or absence of
Master Mix or Primer Set

Faint or no signal
from both the DNA

Repeat amplification.

Control 007 and the

DNA test samples at No activation of DNA Polymerase

Repeat amplification, making sure to hold reactions initially
at 95°C for 1 minute.

all loci
Master Mix not vortexed

thoroughly before aliquoting

Vortex the Master Mix thoroughly.

Primer Set exposed to too much
light

Store the Primer Set protected from light.

Evaporation.

Ensure that the plate is properly sealed with film and that
you used a compression pad with the 9700 thermal cycler (a
compression pad is not needed with the Veriti® thermal
cycler).

PCR System malfunction

Refer to the thermal cycler user’s manual and check
instrument calibration.

Use of incorrect thermal cycling
parameters

Check the protocol for correct thermal cycling parameters.

MicroAmp® Base used with tray/
retainer set and tubes in
GeneAmp® 9700

Remove MicroAmp® Base from tray/retainer set and repeat
test.

Insufficient PCR product
electrokinetically injected

Prepare PCR product as described in “Prepare samples for
electrophoresis on the 3500/3500xL instruments” on

page 38, or “Prepare samples for electrophoresis on the
3130/3130xL instruments” on page 43.

Degraded formamide

Check the storage of formamide; do not thaw and refreeze
multiple times. Try Hi-Di™ Formamide.
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Observation

Possible causes

Recommended actions

Positive signal from
Control DNA 007 but
partial or no signal
from DNA test
samples

Quantity of DNA test sample is
below assay sensitivity

Quantify DNA and (when possible) add 1.0 ng of DNA. For
low concentration samples, add up to 10 uL of the DNA
sample to the reaction mix (see “Prepare the amplification
kit reactions” on page 22).

Test sample contains high
concentration of PCR inhibitor (for
example, heme compounds,
certain dyes

Quantify DNA and add minimum necessary volume. Repeat
test.

Wash the sample in Centricon®-100 centrifugal filter unit.
Repeat test.

Test sample DNA is severely
degraded

The Quantifiler® HP and Trio Kits can help evaluate sample
integrity during the quantification step. If DNA is degraded,
reamplify with an increased amount of DNA or use the
AmpF(STR MiniFiler™ Kit.

Dilution of test DNA in water or
wrong buffer (for example, TE
formula with incorrect EDTA
concentration)

Redilute DNA using low TE buffer.

More than expected
number of alleles
present at a locus

Secondary gene duplication at
DYS385 and/or DYF38751.

Some samples may exhibit uneven peak height ratios at
these markers due to either the stochastic effects of the
PCR or a secondary duplication event in one of the alleles.
We recommend that allele calls be made based on peaks
that are present (conservative approach) unless additional
evidence is gathered to conclusively demonstrate that a
secondary duplication event has taken place.

Presence of exogenous DNA

Use appropriate techniques to avoid introducing foreign DNA
during laboratory handling.

Amplification of stutter product
(-1 repeat unit position)

Mixed sample

See “Stutter products” on page 69.

Incomplete 3" A base addition
(n-1 nt position)

Be sure to include the final extension step of 60°C for
22 minutes in the PCR.

Signal exceeds dynamic range of
instrument (off-scale data)

Check that you are using the recommended number of PCR
cycles (see “Perform PCR” on page 31). Repeat PCR
amplification using reduced input DNA amount or use your
laboratory’s SOP to analyze off-scale data.

Gene duplication

To confirm duplication, re-amplify with a different sample
from the same individual.

Poor spectral separation (bad
matrix)

Follow the steps for creating a spectral file.

Confirm that Filter Set J6 modules are installed and used for
analysis.

Too much DNA in reaction

Use recommended amount of template DNA (1.0 ng).

Incomplete denaturation of double
stranded DNA

Use recommended amount of Hi-Di™ Formamide and
perform heat denaturation step according to the instructions
in “Perform electrophoresis” on page 33.

Some but not all loci
visible on
electropherogram of
DNA Test Samples

Less than 25 pL of PCR volume
was used

Repeat amplification using the recommended PCR volume
of 25 pL.
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Appendix BTroubleshooting E

Observation

Possible causes

Recommended actions

STR profiles contain
many off-scale
alleles

DNA quantitation was not
performed or not accurate

Verify the accuracy of the DNA quantitation protocol.

Poor peak height
balance

Incorrect thermal cycling
parameters

Check the protocol for correct thermal cycling parameters.
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C Ordering information

Equipment and materials not included

Table 10 Equipment

Equipment

Source

3500/3500xL Genetic Analyzer
Applied Biosystems® 3500/3500xL Genetic Analyzer for Human Identification

Applied Biosystems® 3130/3130x( Genetic Analyzer

Contact your local Life
Technologies sales representative

Veriti® 96-Well Thermal Cycler 4479071

GeneAmp® PCR System 9700 with the Silver 96-Well Block N8050001
GeneAmp® PCR System 9700 with the Gold-plated Silver 96-Well Block 4314878

Silver 96-Well Sample Block N8050251
Gold-plated Silver 96-Well Sample Block 4314443

Tabletop centrifuge with 96-Well Plate Adapters (optional MLS (major laboratory supplier]
Harris Micro-Punch® tool, 1.2 mm MLS

Copan® NUCLEIC-CARD™ collection device 4473980

Copan® NUCLEIC-CARD™ collection device, 1 Spot 4474001

Copan® NUCLEIC-CARD™ Color; 1 spot 4473974

CPA200 Semi-Automated Punch Instrument with a 1.2 mm punch head

CPA300 Fully-Automated Punch Instrument with a 1.2 mm punch head

Contact your local Life
Technologies support
representative for information.

96 well, deep well plate 4392904
Table 11 Software
Software Source

3500/3500xL Data Collection Software v2 (RUQ) 4475183%
HID Updater 3500 Data Collection Software v2 4480670%
3130 Data Collection Software v4 44751051
3130x! Data Collection Software v4 4475126
3130/3730 Data Collection Software v4 6-Dye Module v1 T

GeneMapper® ID-X Software v1.4 Full Installation 4479707
GeneMapper® /D-X Software v1.4 Client Installation 4479711

T Contact your Life Technologies HID representative.
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Table 12 Other items

Item? Source
Yfiler® Plus PCR Amplification Kit, 100 reaction 4484678
Yfiler® Plus PCR Amplification Kit, 500 reaction 4482730
Prep-n-Go™ Buffer; (5 tubes) 1000 tests 4467079
Prep-n-Go™ Buffer for buccal swabs, 200 reactions 4471406
3130 Analyzer materials
96-Well Plate Septa 4315933
Reservoir Septa 4315932
3100/3130x! Genetic Analyzer Capillary Array, 36-cm 4315931
POP-4® Polymer for 3100/3100-Avant Genetic Analyzers 4316355
GeneScan™ 600 LIZ® Size Standard v2.0 4408399
Running Buffer, 10X 402824
Hi-Di™ Formamide 4311320
DS-36 Matrix Standard Kit (Dye Set Jé) 4425042
MicroAmp® Optical 96-Well Reaction Plate N8010560
3130x! Analyzer materials
96-Well Plate Septa 4315933
Reservoir Septa 4315932
3100/3130x! Genetic Analyzer Capillary Array, 36-cm 4315931
POP-4® Polymer for 3130/3130x{ Genetic Analyzers 4352755
GeneScan™ 600 LIZ® Size Standard v2.0 4408399
Running Buffer, 10X 402824
DS-36 Matrix Standard Kit (Dye Set J6) 4425042
MicroAmp® Optical 96-Well Reaction Plate N8010560
Hi-Di™ Formamide 4311320

For a complete list of parts and accessories for the 3130x( instrument, refer to Appendix A of the 3130/3130x( Genetic
Analyzers Maintenance, Troubleshooting, and Reference Guide (Pub. no. 4352716).

3500/3500xL Analyzer materials

Anode buffer container (ABC) 4393927
Cathode buffer container (CBC) 4408256
POP-4® polymer (960 samples) for 3500/3500xL Genetic Analyzers 4393710
POP-4® polymer (384 samples) for 3500/3500xL Genetic Analyzers 4393715
GeneScan™ 600 LIZ® Size Standard v2.0 4408399
DS-36 Matrix Standard Kit (Dye Set J6) 4425042
Conditioning reagent 4393718
8-Capillary array, 36 cm for 3500 Genetic Analyzers 4404683
24-Capillary array, 36 cm for 3500xL Genetic Analyzers 4404687
96-well retainer & base set (Standard) 3500/3500xL Genetic Analyzers 4410228
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Item?

Source

8-Tube retainer & base set (Standard) for 3500/3500xL Genetic Analyzers
8-Strip Septa for 3500/3500xL Genetic Analyzers

4410231
4410701

96-Well Septa for 3500/3500xL Genetic Analyzers

4412614

Septa Cathode Buffer Container, 3500 series

4410715

For a complete list of parts and accessories for the 3500/3500xL instrument, refer to the 3500/3500xL Genetic Analyzer User

Guide (Pub. no. 4401661).
PCR amplification

MicroAmp® 96-Well Tray N8010541
MicroAmp® Reaction Tube with Cap, 0.2-mL N8010540
MicroAmp® 8-Tube Strip, 0.2-mL N8010580
MicroAmp® 8-Cap Strip N8010535
MicroAmp® 96-Well Tray/Retainer Set 403081
MicroAmp® 96-Well Base N8010531
MicroAmp® Clear Adhesive Film 4306311
MicroAmp® Optical Adhesive Film 4311971
MicroAmp® Optical 96-Well Reaction Plate N8010560
Other user-supplied materials

Hi-Di™ Formamide, 25-mL 4311320
Aerosol resistant pipette tips MLS
Microcentrifuge tubes MLS
Pipettors MLS
Tape, labeling MLS
Tube, 50-mL Falcon MLS
Tube decapper, autoclavable MLS
Deionized water, PCR grade MLS
Vortex MLS

t For the Safety Data Sheet (SDS) of any chemical not distributed by Life Technologies, contact the chemical manufacturer. Before handling any
chemicals, refer to the SDS provided by the manufacturer, and observe all relevant precautions.
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PCR Work Areas

Work area setup and labdesign............ ... i 113
PCRsetupworkarea......... ...t 113
Amplified DNA workarea . ..............uuuuiiiiiiiiinnnn 114

Work area setup and lab design

Many resources are available for the appropriate design of a PCR laboratory. If you are
using the Yfiler® Plus PCR Amplification Kit for:

e Forensic DNA testing, refer to “Forensic Laboratories: Handbook for Facility
Planning, Design, Construction and Moving,” National Institute of Justice, 1998

* Parentage DNA testing, refer to the “Guidance for Standards for Parentage
Relationship Testing Laboratories,” American Association of Blood Banks, 7th
edition, 2004

The sensitivity of the Yfiler® Plus Kit (and other PCR-based tests) enables
amplification of minute quantities of DNA, necessitating precautions to avoid
contamination of samples yet to be amplified (Kwok and Higuchi, 1989).

Also take care while handling and processing samples to prevent contamination by
human DNA. Wear gloves at all times and change them frequently. Close sample tubes
when not in use. Limit aerosol dispersal by handling sample tubes and reagents
carefully.

Note: We do not intend these references for laboratory design to constitute all
precautions and care necessary for using PCR technology.

PCR setup work area

IMPORTANT! These items should never leave the PCR Setup Work Area.

e Calculator

* Gloves, disposable

¢ Marker pen, permanent
¢ Microcentrifuge

* Microcentrifuge tubes, 1.5-mL, or 2.0-mL, or other appropriate clean tube (for
Master Mix preparation)

* Microcentrifuge tube rack
* Pipette tips, sterile, disposable hydrophobic filter-plugged
¢ DPipettors
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Amplified DNA work area

¢ Tube decapper, autoclavable

e Vortex

Amplified DNA work area

IMPORTANT! Place the thermal cyclers in the Amplified DNA Work Area.

You can use the following systems:
* GeneAmp® PCR System 9700 with the Silver 96-Well Block
* GeneAmp® PCR System 9700 with the Gold-plated Silver 96-Well Block

IMPORTANT! The Yfiler® Plus Kit is not validated for use with the GeneAmp®
PCR System 9700 with the Aluminium 96-Well Block. Use of this thermal cycling
platform may adversely affect performance of the Yfiler® Plus Kit.

e Veriti® 96-Well Thermal Cycler
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Safety

WARNING! GENERAL SAFETY. Using this product in a manner not specified
in the user documentation may result in personal injury or damage to the
instrument or device. Ensure that anyone using this product has received
instructions in general safety practices for laboratories and the safety
information provided in this document.

* Before using an instrument or device, read and understand the safety
information provided in the user documentation provided by the
manufacturer of the instrument or device.

* Before handling chemicals, read and understand all applicable Safety Data
Sheets (SDSs) and use appropriate personal protective equipment (gloves,
gowns, eye protection, etc). To obtain SDSs, see the “Documentation and
Support” section in this document.
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Chemical safety

Chemical safety

WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards,
ensure laboratory personnel read and practice the general safety guidelines for
chemical usage, storage, and waste provided below, and consult the relevant
SDS for specific precautions and instructions:

Read and understand the Safety Data Sheets (SDSs) provided by the
chemical manufacturer before you store, handle, or work with any chemicals
or hazardous materials. To obtain SDSs, see the “Documentation and
Support” section in this document.

Minimize contact with chemicals. Wear appropriate personal protective
equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing).

Minimize the inhalation of chemicals. Do not leave chemical containers
open. Use only with adequate ventilation (for example, fume hood).

Check regularly for chemical leaks or spills. If a leak or spill occurs, follow
the manufacturer's cleanup procedures as recommended in the SDS.
Handle chemical wastes in a fume hood.

Ensure use of primary and secondary waste containers. (A primary waste
container holds the immediate waste. A secondary container contains spills
or leaks from the primary container. Both containers must be compatible
with the waste material and meet federal, state, and local requirements for
container storage.)

After emptying a waste container, seal it with the cap provided.
Characterize (by analysis if necessary) the waste generated by the particular
applications, reagents, and substrates used in your laboratory.

Ensure that the waste is stored, transferred, transported, and disposed of
according to all local, state/provincial, and/or national regulations.
IMPORTANT! Radioactive or biohazardous materials may require special
handling, and disposal limitations may apply.

Biological hazard safety

g WARNING! Potential Biohazard. Depending on the samples used on this
instrument, the surface may be considered a biohazard. Use appropriate
decontamination methods when working with biohazards.
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Biological hazard safety

& WARNING! BIOHAZARD. Biological samples such as tissues, body fluids,

infectious agents, and blood of humans and other animals have the potential to
transmit infectious diseases. Follow all applicable local, state/provincial, and/or
national regulations. Wear appropriate protective equipment, which includes
but is not limited to: protective eyewear, face shield, clothing/lab coat, and
gloves. All work should be conducted in properly equipped facilities using the
appropriate safety equipment (for example, physical containment devices).
Individuals should be trained according to applicable regulatory and company/
institution requirements before working with potentially infectious materials.
Read and follow the applicable guidelines and/or regulatory requirements in
the following:
In the U.S.:

¢ U.S. Department of Health and Human Services guidelines published in
Biosafety in Microbiological and Biomedical Laboratories found at:
www.cdc.gov/biosafety

® Occupational Safety and Health Standards, Bloodborne Pathogens
(29 CFR§1910.1030), found at: www.access.gpo.gov/nara/cfr/waisidx_01/
29c¢fr1910a_01.html

* Your company’s/institution’s Biosafety Program protocols for working with/
handling potentially infectious materials.

¢ Additional information about biohazard guidelines is available at:
www.cdc.gov

In the EU:

Check local guidelines and legislation on biohazard and biosafety precaution
and refer to the best practices published in the World Health Organization
(WHO) Laboratory Biosafety Manual, third edition, found at: www.who.int/
csr/resources/publications/biosafety/ WHO_CDS_CSR_LYO_2004_11/en/
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E Safety

Biological hazard safety
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Documentation and Support

Related documentation

Document title nF:Jar:\tber

Applied Biosystems® 3130/3130xl Genetic Analyzers Getting Started Guide 4352715
Applied Biosystems® 3130/3130x( Genetic Analyzers Maintenance, Troubleshooting, and Reference Guide 4352716
Applied Biosystems® 3130/3130x! Genetic Analyzers Quick Reference Card 4362825
Applied Biosystems® 3130/3130x( Genetic Analyzers AB Navigator Software Administrator Guide 4359472
Applied Biosystems® 3130/3100xt DNA Analyzers User Guide 4331468
Applied Biosystems® 3500/3500xL Genetic Analyzer Quick Reference Card 4401662
Applied Biosystems® 3500/3500xL. Genetic Analyzer User Guide, Data Collection v2.0 4476988

Applied Biosystems® 3500/3500xL Genetic Analyzer User Bulletin: Solutions to issues related to software, data, 4445098
hardware, and consumables

Note: Additional user bulletins may be available at www.lifetechnologies.com

GeneAmp® PCR System 9700 Base Module User’s Manual N805-0200
Veriti® 96-Well Thermal Cycler AmpF(STR® Kit Validation User Bulletin 4440754
Quantifiler® HP and Trio DNA Quantification Kits User Guide 4485354
Quantifiler® Kits: Quantifiler® Human DNA Quantification Kit and Quantifiler® Y Human Male DNA 4344790
Quantification Kit User’s Manual

PrepFiler® Forensic DNA Extraction Kit User Guide 4390932
GeneMapper® ID-X Software Version 1.2 Reference Guide 4426481
GeneMapper® ID-X Software Version 1.2 Quick Reference Guide 4426482
GeneMapper® ID-X Software Version 1.4 User Bulletin 4477684

Portable document format (PDF) versions of this guide and the documents listed above
are available at www.lifetechnologies.com.

Note: To open the user documentation available from the our web site, use the Adobe®
Acrobat® Reader® software available from www.adobe.com.

Obtain SDSs

Safety Data Sheets (SDSs) are available from www.lifetechnologies.com/sds.

Note: For the SDSs of chemicals not distributed by Life Technologies, contact the
chemical manufacturer.
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Documentation and Support
Obtain support

Obtain support

For HID support:

¢ In North America - Send an email to HIDTechSupport@lifetech.com, or call
888-821-4443 option 1.

* Outside North America — Contact your local support office.
For the latest services and support information for all locations, go to:
www.lifetechnologies.com

At the website, you can:

* Access worldwide telephone and fax numbers to contact Technical Support and
Sales facilities

® Search through frequently asked questions (FAQs)
¢ Submit a question directly to Technical Support

* Search for user documents, SDSs, vector maps and sequences, application notes,
formulations, handbooks, certificates of analysis, citations, and other product
support documents

¢ Obtain information about customer training

¢ Download software updates and patches

Limited Product Warranty

Life Technologies and/or its affiliate(s) warrant their products as set forth in the Life
Technologies' General Terms and Conditions of Sale found on Life Technologies’
website at www.lifetechnologies.com/termsandconditions. If you have any questions,
please contact Life Technologies at www.lifetechnologies.com/support.
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import panels, bins, and stutter 48
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lysate, prepare 28

M

master mix

volume per reaction 27
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materials and equipment
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mixed samples 87
multicomponent analysis 15
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chemical 116
Safety Data Sheets (SDSs), obtaining 123
sample discs, size 26
sample preparation 23

DNA negative control 23

DNA positive control 23

standards 17
software, instrument compatibility 15
spectral calibration, 6-dye 38, 43
stutter

check version 47

import 48
stutter filters, plus and minus 69
stutter peaks, plus and minus 69
support, obtaining 124
swab substrates, prepare for PCR 28

Yfiler® Plus PCR Amplification Kit User Guide

Index

T

technical support 124
thermal cyclers
for use with kit 114
programming conditions 23, 31
training, information on 124
treated paper 26
treated paper, prepare for PCR 26

U

untreated paper, prepare for PCR 26
user-supplied reagents 20

'

validation
characterization of loci 81
developmental 63
experiments to evaluate 63
importance of 63
mixture studies 87
sensitivity 83
thermal cycler parameters 65

w

warranty 124
Whatman FTA Cards 9
work area
amplified DNA 114
PCR setup 113
setup and lab design 113
workflow overview 13, 14

127



Index

128 Yfiler® Plus PCR Amplification Kit User Guide






Headquarters
5791 Van Allen Way | Carlsbad, CA 92008 USA | Phone +1 760 603 7200 | Toll Free in USA 800 955 6288

For support visit www.lifetechnologies.com\support technologies

www.lifetechnologies.com
30 October 2014


https:\\www.lifetechnologies.comupport
http://www.lifetechnologies.com

	Yfiler® Plus PCR Amplification Kit User Guide
	Copyright
	Contents
	About This Guide
	Revision history
	Purpose

	Chapter 1. Overview
	Product overview
	Purpose
	Product description
	Substrates
	About the primers
	Loci amplified by the kit
	Allelic ladder profile
	Control DNA 007 profile

	Workflow overview for casework samples
	Workflow overview for database samples
	Instrument and software overview
	Data Collection and GeneMapper® ID-X Software
	Instrument and software compatibility
	About multicomponent analysis
	How multicomponent analysis works

	Materials and equipment
	Kit contents and storage
	Standards for samples


	Chapter 2. Perform PCR
	Section 2.1 Amplification from extracted DNA
	Required user-supplied reagents
	DNA quantification
	Importance of quantification
	Methods of quantifying DNA

	Prepare the amplification kit reactions
	Perform PCR

	Section 2.2 Direct amplification of DNA
	Optimize PCR cycle number
	Select samples and prepare plates
	Determine optimum conditions

	Treated or untreated paper: prepare reactions
	Sample prep guidelines
	Prepare the reactions

	Swab substrates: prepare reactions
	Sample prep guidelines
	Prepare the sample lysate (room temperature protocol)
	Prepare the sample lysate (heat protocol)
	Prepare the reactions
	Store the sample lysate

	Perform PCR


	Chapter 3. Perform electrophoresis
	Allelic ladder requirements
	Section 3.1 3500/3500xL instruments
	Set up the 3500/3500xL instruments for electrophoresis
	Reagents and parts
	Electrophoresis software setup and reference documents
	Obtain and run the HID Updater
	Create a Yfiler Plus® assay
	Modify 3500 QC protocol size- calling method
	Perform spectral calibration

	Prepare samples for electrophoresis on the 3500/3500xL instruments

	Section 3.2 3130/3130xl instruments
	Set up the 3130/3130xl instruments for electrophoresis
	Reagents and parts
	Electrophoresis software setup and reference documents
	Obtain and activate the 6-dye license for the instrument
	Perform spectral calibration

	Prepare samples for electrophoresis on the 3130/3130xl instruments


	Chapter 4. Analyze Data
	Overview of GeneMapper® ID-X Software v1.4
	Instruments
	Before you start

	Set up GeneMapper® ID-X Software for data analysis
	Panel, bin, and stutter file version
	Before using the software for the first time
	Check panel, bin, and stutter file version
	Import panels, bins, and marker stutter
	Create an analysis method
	General tab settings
	Allele tab settings
	Peak Detector tab settings
	Peak Quality tab settings
	SQ & GQ tab settings
	Create a size standard

	Analyze and edit sample files with GeneMapper® ID-X Software
	Examine and edit a project
	For more information

	Chapter 5. Experiments and Results
	Overview
	Importance of validation
	Experiment conditions

	Developmental validation
	SWGDAM guideline 2.2.1
	SWGDAM guideline 3.9.2
	PCR components
	Thermal cycler parameters

	Accuracy, precision, and reproducibility
	SWGDAM Guideline 3.5
	Accuracy
	Precision and size windows

	Extra Peaks in the electropherogram
	Causes of extra peaks
	Stutter products
	Addition of 3´A
	About artifacts
	Other DNA- dependent artifacts

	Characterization of loci
	SWGDAM Guideline 3.1
	Nature of the polymorphisms
	Inheritance
	Mapping

	Species specificity
	SWGDAM Guideline 3.2

	Sensitivity
	SWGDAM Guideline 3.3
	Effect of DNA quantity on results and importance of quantitation

	Stability
	SWGDAM Guideline 3.4
	Lack of amplification of some loci
	Effect of inhibitors
	Degraded DNA

	Mixture studies
	SWGDAM Guideline 3.8
	Male/female mixture studies
	Male/male mixture studies

	Population data
	SWGDAM YSTR Guideline 10.1
	Overview
	Population samples used in these studies
	Gene diversity values
	Analyzing the population data

	Mutation rate

	Appendix A. Table of Precision Results
	Table of typical precision results

	Appendix B. Troubleshooting
	Appendix C. Ordering information
	Equipment and materials not included

	Appendix D. PCR Work Areas
	Work area setup and lab design
	PCR setup work area
	Amplified DNA work area

	Appendix E. Safety
	Chemical safety
	Biological hazard safety

	Bibliography
	Documentation and Support
	Related documentation
	Obtain SDSs
	Obtain support
	Limited Product Warranty

	Index
	Back Cover



<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /PageByPage
  /Binding /Left
  /CalGrayProfile (None)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.4
  /CompressObjects /Off
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJobTicket true
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.1000
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize false
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Preserve
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 150
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages false
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 150
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages false
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /AntiAliasMonoImages true
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages false
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth 8
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects true
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile (None)
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName (http://www.color.org)
  /PDFXTrapped /False

  /CreateJDFFile false
  /SyntheticBoldness 1.000000
  /Description <<
    /JPN <FEFF3053306e8a2d5b9a306f300130d330b830cd30b9658766f8306e8868793a304a3088307353705237306b90693057305f00200050004400460020658766f830924f5c62103059308b3068304d306b4f7f75283057307e305930023053306e8a2d5b9a30674f5c62103057305f00200050004400460020658766f8306f0020004100630072006f0062006100740020304a30883073002000520065006100640065007200200035002e003000204ee5964d30678868793a3067304d307e30593002>
    /DEU <>
    /FRA <>
    /PTB <>
    /DAN <>
    /NLD <>
    /ESP <>
    /SUO <>
    /ITA <>
    /NOR <>
    /SVE <>
    /ENU <>
  >>
>> setdistillerparams
<<
  /HWResolution [600 600]
  /PageSize [612.000 792.000]
>> setpagedevice


